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MODULE 3: MICROSOFT DYNAMICS NAV SERVER 

Module Overview 
This module describes the Microsoft Dynamics NAV Server, the middle tier of the 
Microsoft Dynamics NAV 2013 architecture. It will introduce you to the Microsoft 
Dynamics NAV security system. Next it explains the different interfaces that you 
can use to administer a Microsoft Dynamics NAV 2013 deployment and what you 
can do in each administration interface. Finally, it will discuss how to set up 
Microsoft Dynamics NAV Server to support logon over a wide area network 
(WAN). 

Objectives 

The objectives are:  

• Explain how to install and configure Microsoft Dynamics NAV Server.  

• Explain how to manage Microsoft Dynamics NAV Server instances. 

• Explain how to administer Microsoft Dynamics NAV Server. 

• Explain how to setup Microsoft Dynamics NAV Server to support wide 
area network connections. 

• Illustrate how to setup Microsoft Dynamics NAV Application Server. 
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Microsoft Dynamics NAV Server 
Microsoft Dynamics NAV Server is a .NET-based Windows® service application 
that works exclusively with SQL Server® databases. Microsoft Dynamics NAV 
Server provides an additional layer of security between clients and the database. It 
uses features of the Windows Communications Foundation to provide another 
layer of user authentication and uses impersonation to make sure that business 
logic is executed in a process that was instantiated by the user who submitted the 
request. This means that authorization and logging of user requests are 
performed on a per-user basis.  

Microsoft Dynamics NAV Server supports different client types such as the 
following: 

• RoleTailored client for Windows 

• Web client 

• Business web services 

• Portal Framework for SharePoint® 2010 

• NAS services 

Installation 

By default, Microsoft Dynamics NAV Server is included as part of the following 
installation options:  

• Server 

• Developer 

Microsoft Dynamics NAV Server is also part of the Install Demo option. However, 
this installation option does not provide any user interaction during setup and will 
install Microsoft Dynamics NAV Server with default components and settings.  

To install the product, follow these steps:  

1. Start Microsoft Dynamics NAV Setup.  
2. On the Welcome to Microsoft Dynamics NAV 2013 Setup page, 

click Next. 
3. On the Microsoft Software License Terms page, select I accept. 
4. On the Microsoft Dynamics NAV Setup page, click Choose an 

installation option. 
5. Click the desired installation option.  

6. On the Specify parameters page, enter the correct configuration 
settings. 

7. Click Apply to start the installation.  
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Microsoft Dynamics NAV Setup will install Microsoft .NET Framework 3.5 SP1 (if 
this is not on the server). 

    Note: Microsoft Dynamics NAV Server can be included as part of the Custom 
Components installation option. It cannot be installed as part of the Client 
installation option. 

Configuration 

Microsoft Dynamics NAV Server can be configured either during setup or after 
setup. During Setup you can customize the default settings for the Microsoft 
Dynamics NAV Server on the Specify parameters page. The information that is 
collected on this page is saved to a configuration file. Please realize that you 
cannot handle all configuration tasks and parameters with Microsoft Dynamics 
NAV Setup. For example, you can configure the instance of SQL Server and 
database to connect to and the TCP/IP port to use for the client. However, you 
cannot configure the users who must have access to the database.   

The figure, Configuring the NAV Server Settings During Setup, shows an overview 
of the default settings that can be customized. 
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FIGURE 3.1: SPECIFY PARAMETERS FOR MICROSOFT DYNAMICS NAV 
SERVER SETTINGS DURING SETUP 

Configuring Microsoft Dynamics NAV Server During Setup 

When you run Microsoft Dynamics NAV 2013 Setup and install Microsoft 
Dynamics NAV Server, you can provide configuration information (on the Specify 
parameters page) that is then used as the configuration for the default Microsoft 
Dynamics NAV Server instance. 

After you install Microsoft Dynamics NAV Server, you can change any of the 
settings that you provided during setup, or any of many other Microsoft Dynamics 
NAV Server settings, by using either the Microsoft Dynamics NAV Server 
Administration tool or the Microsoft Dynamics NAV PowerShell API. This is 
discussed later in this module. Although it is not recommended, you can also 
change configuration by manually editing the CustomSettings.config file in the 
Microsoft Dynamics NAV Server installation folder. (By default, Microsoft 
Dynamics NAV Server is installed in C:\Program Files\Microsoft Dynamics 
NAV\70\Service\. However, you can customize the installation path during setup.) 

The parameters that you see in the Specify parameters pane depend on which 
components you have selected for configuration. When you install Microsoft 
Dynamics NAV Server, you are prompted for settings that relate to Microsoft 
Dynamics NAV Server itself and to the computer that is running SQL Server and 
the instance to which Microsoft Dynamics NAV Server will connect. 
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All parameters identified with an asterisk are required parameters. You cannot 
continue in Setup if you leave any of these parameters blank. 

Category/Parameter Description 

Server/Send Feedback Specifies whether Microsoft Dynamics 
NAV Server can collect basic and 
anonymous information about your 
hardware configuration and how you 
use Microsoft Dynamics NAV Server. 
Information is automatically sent to 
Microsoft, which uses it to identify 
trends and usage patterns and to 
improve its software. 
Yes enables the collection and 
sending of this data. 
 

Server/Server Port The listening TCP port for 
RoleTailored clients for Windows. 
Default: 7046 

Valid range: 1-65535 

Server/Soap Web Service Port The listening HTTP port for Microsoft 
Dynamics NAV SOAP web services. 

Default: 7047 
Valid range: 1-65535 

Server/OData Web Service 
Port 

The listening HTTP port for Microsoft 
Dynamics NAV OData web services. 
Default: 7048 
Valid range: 1-65535 

Server/Management Service 
Port 

The port that is used for Microsoft 
Dynamics NAV Management services.  
Default: 7045 
Valid range: 1-65535 

SQL Server Database 
Components/SQL Server 

The computer that is running SQL 
Server. 

SQL Server Database 
Components/SQL Server 
Instance 

The instance of SQL Server to which 
Microsoft Dynamics NAV Server 
connects. If you leave this parameter 
blank, Microsoft Dynamics NAV Server 
connects to the default instance of 
SQL Server. 
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Category/Parameter Description 

SQL Server Database 
Components/SQL Database 

The SQL Server database. 
Default: Demo Database NAV (7-0) 

Add rule to Windows Firewall Specifies whether Microsoft Dynamics 
NAV Setup adds a rule to Windows 
Firewall to enable Microsoft Dynamics 
NAV Server instances on the 
destination computer to communicate 
with RoleTailored clients for Windows 
on other computers, through the 
specified Server Port.  
Defaults: Yes for the Client or Server 
installation options, where the 
assumption is that Microsoft Dynamics 
NAV Server is installed on a different 
computer.  
No for Demo and Developer options, 
where the assumption is that the 
RoleTailored client for Windows is 
installed on the same computer.  
If the destination computer uses a 
firewall other than Windows Firewall, 
or if networking is not configured on 
the destination computer, then this 
option must be set to No or Setup will 
not be completed successfully. 

Click Apply when you have finished entering values to return to the Specify 
parameters page in Setup. 

After you finish running Setup, you can modify Microsoft Dynamics NAV Server By 
Using any of the methods described in the following section. 

Configuring Microsoft Dynamics NAV Server After Setup 

After you install Microsoft Dynamics NAV Server, you can change any of the 
settings that you provided during Setup, or any of many other Microsoft 
Dynamics NAV Server settings, in any of the following ways: 

1. Using the Microsoft Dynamics NAV Server Administration tool. This is 
discussed later in this module. 

2. Using the Microsoft Dynamics NAV PowerShell API. This is discussed 
later in this module. 
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3. By directly editing CustomSettings.config, the Microsoft Dynamics 
NAV Server configuration file. By default, this file is located in 
C:\Program Files\Microsoft Dynamics 
NAV\70\Service\Instances\<instancename>. Avoid direct editing of 
the configuration file because if you make any mistakes in typing or if 
you change the wrong parameter, then Microsoft Dynamics NAV 
Server may be unable to start the instance.  

    Note: After you modify a Microsoft Dynamics NAV Server setting, you must 
restart the associated Microsoft Dynamics NAV Server instance before any changes 
can take effect.  

Server Instances and Service Types 

A Microsoft Dynamics NAV Server instance is the service through which the 
various types of Microsoft Dynamics NAV clients interact with the Microsoft 
Dynamics NAV SQL Server database. It is a distinct service in Windows and is the 
middle tier between the client and the data tiers. 
 
When you install Microsoft Dynamics NAV Server on a computer, there is a single 
default instance. If your organization requires additional instances, then you can 
either install Microsoft Dynamics NAV Server on additional computers or create 
additional instances on the original Microsoft Dynamics NAV Server. You can 
create (and manage) additional server instances by using the Microsoft Dynamics 
NAV Server Administration tool. This procedure is described later in this module. 

In a Microsoft Dynamics NAV Server instance, you can have multiple service types. 
Each service type, such as client services or OData web services, corresponds to a 
particular type of client that can connect to SQL Server through Microsoft 
Dynamics NAV Server. The only type of client that does not have its own service 
type is the Microsoft Dynamics NAV Portal Framework for Microsoft SharePoint® 
2010. This is configured and managed separately. (This is described in the next 
module.) 

Be aware that restarting the server instance affects all service types within that 
instance. For example, RoleTailored client for Windows users are disconnected, 
and web service applications are interrupted. Therefore, if you plan to run 
different types of services on a single computer running Microsoft Dynamics NAV 
Server, run the different services types in separate service instances. Your 
computer should have sufficient memory to run multiple service instances. For 
example, if you plan to use both the client services and OData web services on a 
single computer running Microsoft Dynamics NAV Server, then you should run the 
client services in one server instance and the OData web services in a separate 
server instance. Then, if you have to change an OData web services setting, then 
you do not affect RoleTailored client for Windows users when you restart the 
instance to enable the change. 
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Security Enhancements 

After you have set up and configured Microsoft Dynamics NAV Server, there are 
several steps that you can follow to improve security. 

Login Account 

When you install Microsoft Dynamics NAV Server, the default configuration 
enables the service to log on by using the NT Authority\Network Service account. 
If Microsoft Dynamics NAV Server and SQL Server are on different computers, 
then we recommend that you configure Microsoft Dynamics NAV Server to log on 
by using a dedicated Windows domain user account instead. This account should 
not be an administrator either in the domain or on any local computer. A 
dedicated domain user account is considered more secure because no other 
services, and therefore no other users, have permissions for this account.  

Disk Quotas 

Client users can send files to be stored on Microsoft Dynamics NAV Server. So, we 
recommend that administrators set up disk quotas on all computers that are 
running Microsoft Dynamics NAV Server. This can prevent users from uploading 
too many files and therefore make the server unstable. Disk quotas track and 
control disk space use for NTFS volumes. This allows administrators to control how 
much data each user can store on a specific NTFS volume. For more information 
about disk quotas, see the Disk Quotas Technical Reference on Microsoft TechNet. 

Limiting Port Access 

The Microsoft Dynamics NAV Setup program opens a port in the firewall on the 
computer where you install Microsoft Dynamics NAV Server. By default, this is 
port 7046. Setup does not limit who or what can connect to this port. To improve 
security, you can consider limiting access to this port to a specific subnet. One way 
is to use netsh, which is a command-line tool for configuring and monitoring 
Windows-based computers at a command prompt.  

For example, the following command limits access to port 7046 to the specified 
addresses and subnets: 

netsh firewall set portopening protocol=TCP port=7046 scope=subnet 
addresses=LocalSubnet 
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Server Administration 
Microsoft Dynamics NAV 2013 provides four interfaces for administration: 

• RoleTailored Client for Windows 

• Development Environment 

• Server Administration Tool 

• PowerShell API 

Please be aware that not all the interfaces provide the same functions for 
administration. Depending on the setting that you want to modify, you will have 
to use a different server administration interface.  

This lesson will first introduce you in the Microsoft Dynamics NAV security system. 
Afterward, it will describe the different administration interfaces. 

The Microsoft Dynamics NAV Security System 

The Microsoft Dynamics NAV security system is built on the principles of 
authentication and authorization. You can use it to define who can access a 
database (users) and to control which objects or tables each user can access within 
each database (permission sets). In addition, you can specify the type of access 
that each user has to these objects and tables, that is, whether they can read, 
modify, enter, and delete data. It even enables you to specify which records table 
each user can access. This means that permissions can be allocated at both the 
table level and the record level. 

Data Security 

In the Microsoft Dynamics NAV security system there are four levels of security: 

• Database  

• Company  

• Object  

• Record  

Graphically, these can be represented as the layers, where the central layer is the 
records in the database. 

Database-Level Security 

The first layer of security when you open Microsoft Dynamics NAV is database 
security. After you start Microsoft Dynamics NAV and try to open the database, 
your credentials are checked. If you are not granted permission to open the 
database, you receive an error message. 
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To open a database, you must connect to a Microsoft Dynamics NAV Server 
instance. A Microsoft Dynamics NAV Server instance can only be connected to 
one database at a time. To open the database, click the Microsoft Dynamics NAV 
menu, and then click Select Server. The Select Server window appears. In this 
window, you can enter the address of the server to which you want to connect. 
The Server Address menu lists recently used server connections. After you have 
entered the correct server address, a list of available companies will appear in the 
Available Companies list.  

Company-Level Security 

After you have gained access to the database, you can select the company whose 
information you want to reach. 

To select a company, click the Microsoft Dynamics NAV menu and then click 
Select Company. The Select Company window appears. This window lists all the 
companies that are created in the current database and that you have access to. A 
Microsoft Dynamics NAV database can contain several companies. Each company 
can use its own tables and can also share tables with other companies. 

Select the company that you want to access click OK, and the company data 
becomes available. If there are companies in the database that you were not 
granted permissions to access, you cannot see their data in this window. 

Object-Level Security  

When you open company data in Microsoft Dynamics NAV, your ability to access 
information is determined by the security system.  

The Microsoft Dynamics NAV security system consists of permission sets and 
permissions that you can assign to users who have access to the company. The 
permission sets determine the access that users have and the tasks that users can 
perform on the objects that exist in the database. 

The security system divides the database into the following objects. 

Object Description 

table Data The actual data that is stored in the tables. 

table The tables themselves. 

Page The pages that are used to view and enter 
data. 

Report The reports that are used to present the 
data. 

Codeunit The codeunits that are used in the 
database. 
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Object Description 

XMLPort The XML ports that are used to import and 
export data. 

MenuSuite The object that contains the menus that are 
displayed in the navigation pane. 

Query The object that you use to specify a dataset 
from the database. 

System The system tables in the database that 
allow the user to make backups, change 
license files, and so on. 

The various permission sets that exist in Microsoft Dynamics NAV determine the 
tasks that you can perform on these objects. 

Record-Level Security 

Record-level security lets you limit the access that a user has to the data in a table. 
You do this by specifying that the user only has permission to access certain 
records in the table.  

You implement record-level security by setting security filters to records. You can 
specify, for example, that a user can only read the records that contain 
information about a particular customer. This means that the user cannot access 
the records that contain information about other customers. 

    Note: Record-level security filters do not support wildcard characters. This 
means that you cannot use * and ? in the filters. You can use the other symbols, 
delimiters, and operators, such as <, >, |, &, .., and =.  

The maximum length of a security filter is 250 characters, but all the delimiters, 
symbols, and operators such as, <, >, |, &, .., and = also count as characters and can 
much reduce the length of the security filters that you can enter.  

Also, security filters are concatenated and therefore the sum of all the security filters 
applied to a user or a permission set cannot exceed 250 characters. 

Record level security filters affect performance in the same way as any other filters 
that are applied by the user. It is important that the record level security filters have 
matching keys in tables that contain a large number of records, and that these keys 
are used. 
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Users and Credential Types  

In Microsoft Dynamics NAV 2013, you use User objects to identify who can access 
the Microsoft Dynamics NAV database. Before you can access the data in the 
database, you have to authenticate by supplying valid credentials. 

Microsoft Dynamics NAV 2013 supports four credential authorization mechanisms 
for Microsoft Dynamics NAV users. When you create a user, you provide 
information, depending on the credential type that you are using in the current 
Microsoft Dynamics NAV Server instance. 

The supported credential types are as follows: 

Windows  

With this credential type, users are authenticated with their Windows credentials 
(Active Directory®, the local workgroup, or just the local computer’s users). Before 
you create a Windows user in the RoleTailored client, there must already be a 
corresponding user in Windows. Windows users, because they are authenticated 
through Windows, are not prompted for credentials when they start the 
RoleTailored client. 

Username  

With this setting, the users are prompted for username/password credentials 
when they start the RoleTailored client. These credentials are then validated 
against Windows authentication by Microsoft Dynamics NAV Server. There must 
already be a corresponding user in Windows. Security certificates are required to 
protect the passing of credentials across a wide area network. This setting should 
typically be used when the Microsoft Dynamics NAV Server is part of an 
authenticating Active Directory domain but the computer where the RoleTailored 
client is installed is not.  

NavUserPassword  

With this setting, authentication is managed by Microsoft Dynamics NAV Server 
but is not based on Windows users or Active Directory. Users are prompted for 
username/password credentials when they start the RoleTailored client. The 
credentials are then validated by an external mechanism. Security certificates are 
required to protect the passing of credentials. This mode is intended for hosted 
environments—for example, where Microsoft Dynamics NAV is implemented in 
Azure.  
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AccessControlService (ACS) 

AccessControlService authentication is relevant only for Microsoft Dynamics NAV 
solutions that are deployed on Windows Azure. Windows Azure Access Control 
Service (ACS) is a cloud-based service that provides user authentication and 
authorization for web applications and services. With ACS, there is no need to 
factor authentication and authorization into your application code. Instead of 
implementing an authentication system with user accounts that are specific to 
your application, you can let ACS orchestrate the authentication and much of the 
authorization of your users. ACS integrates with standards-based identity 
providers, including enterprise directories such as Active Directory, and web 
identities such as Windows Live ID, Google, Yahoo!, and Facebook. 

You do not have to create user logons in SQL Server before you create Microsoft 
Dynamics NAV users. 

You can create users that can be used with multiple credential types. For example, 
you could create a user who would automatically be logged on to the 
RoleTailored client without having to present credentials when the credential type 
is Windows, but would be prompted for a user name (the value of the User Name 
field) and a password when the credential type is Username. 

You specify which credential type is used for a particular Microsoft Dynamics NAV 
Server instance by configuring the relevant RoleTailored client for Windows 
configuration file and Microsoft Dynamics NAV Server instance configuration.  

A separate instance of the ClientUserSettings.config file is maintained for each 
client user—you must edit the configuration for each instance of the file. The 
default location for this file is 
C:\Users\<username>\AppData\Roaming\Microsoft\Microsoft Dynamics NAV\70, 
where <username> is the name of the user. 

    Note: All users of a given Microsoft Dynamics NAV Server instance must use 
the same credential type.  

Permission Sets and Permissions 

After you have defined a user, you can assign it to permission sets. A permission 
set is a set of permissions for a set of objects in the Microsoft Dynamics NAV 
database that you can assign to one or more users. By default, several predefined 
permission sets are provided in the RoleTailored client. You can use these 
permission sets as defined, modify them, or create your own permission sets. 
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Special Permission Sets 

The following permission sets have special definitions that you should note as you 
implement permissions and security for RoleTailored client users. 

Permission Set Definition 

SUPER Can read, use, change, and delete all data 
and all application objects within the 
scope of your license. Microsoft Dynamics 
NAV 2013 requires that at least one user 
be assigned this permission set in each 
database.  

You cannot modify permissions for the 
SUPER permission set. 

SUPER (DATA) Can read, use, change, and delete all data. 
You typically assign this permission set to 
an accounting manager who has to work 
with all data but does not have to change 
Microsoft Dynamics NAV. 

ALL Can use fundamental but not high-
security tables and functions. You must 
assign this permission set to all users 
except SUPER because it is a prerequisite 
for all other permission sets. 

BASIC Can access required system tables and 
other fundamental tables--a prerequisite 
for all other permission sets.  When you 
create a new database, you must import 
the BASIC permission set from an XML file.  

Indirect Permissions 

When you define permissions, set the values for table permission to Yes, Indirect, 
or blank, which indicates no permission. You can use indirect permission to use an 
object only through another object.  

For example, a user can have permission to run codeunit 80, Sales-Post. The Sales-
Post codeunit performs many tasks, including inserting records in table 21, 
Customer Ledger Entry. When the user runs the Sales-Post codeunit, Microsoft 
Dynamics NAV checks whether the user has permission to insert records in the 
Customer Ledger Entry table. If the user does not have permission, then the 
codeunit cannot complete its tasks, and the user receives an error message. If the 
user has permission, the codeunit runs successfully. 
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However, the user is not granted direct insert permissions to the Customer Ledger 
Entry table: he cannot manually insert new records in the Customer Ledger Entry 
table. The only way to insert records in the Customer Ledger Entry table is 
through other objects, that is, the journal and document posting codeunits.  

So when a user has indirect permission to a table, that user can only modify the 
table by running another object that has permission to modify the specific table. 
The user can only modify a table when doing this from supported application 
areas and cannot run the feature accidentally or maliciously by other methods. 

First User Automatically Assigned the SUPER Permission Set 

When a user creates a Microsoft Dynamics NAV database, that user is 
automatically assigned the SUPER permission set in the Microsoft Dynamics NAV 
security system. There are several ways to create a database, including performing 
a Demo install (which creates the CRONUS International Ltd. demonstration 
database) and restoring a previously backed-up database. The SUPER permission 
set allows the user to read, use, change, and delete all data and all application 
objects within the scope of the current Microsoft Dynamics NAV license. This user 
is then responsible for creating additional users and for assigning appropriate 
permission sets to those users. 

For Microsoft Dynamics NAV to work correctly, the SUPER user must have the 
appropriate permissions in SQL Server, such as system administrator or db_creator 
permissions. When Microsoft Dynamics NAV 2013 Setup creates the CRONUS 
International Ltd. demonstration database in SQL Server, the current user is added 
as a database user with db_owner permissions. 

Profiles and Role Centers 

After you have created users and assigned them to permission sets, you can add 
users to profiles. This links them to Role Centers in the RoleTailored client. 

Profiles are collections of Microsoft Dynamics NAV users who share the same Role 
Center. Profiles can be created or edited in the RoleTailored client. 

A Role Center is a home page in Microsoft Dynamics NAV 2013 for all users of a 
profile. It is a type of page on which you can put different parts. Each part is a 
container in which you can host other pages or predefined system parts, such as 
an Outlook® part or parts for adding tasks, notifications, or notes. For example, 
the Order Processor Role Center is configured to reflect the tasks and priorities of 
an order processor. In the RoleTailored client, the profile that is used appears in 
the header of the Role Center’s main content area.  

There are 21 Role Centers available in Microsoft Dynamics NAV. 
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Configuration and personalization are ways to customize the RoleTailored client 
for Windows to suit the daily requirements and tasks of groups of users or 
individual users. 

• Configuration: Modifications that an administrator implements, such 
as presenting a custom home page to all users of a Role Center. 

• Personalization: Modifications that an end-user makes, such as 
changing the user interface of a page to fit individual requirements 
and preferences. 

Configuration 

An administrator, SUPER user, or Microsoft Certified Partner frequently performs 
Role Center configuration tasks. This person configures the Role Center for a 
specific role and then assigns users to the Role Center. For example, when Susan, 
an order processor, uses the RoleTailored client, she sees the Order Processor Role 
Center. This was customized to help her perform her daily tasks. In configuring 
Susan's Role Center, the administrator has added or removed UI elements. This 
includes items in the navigation pane, page parts, and FactBoxes. 

The following elements in Role Centers can be configured: 

• Navigation pane 

• FactBoxes 

• Home parts 

• Lists 

• Task pages 

• Action menus 

• Report menus 

To configure a Role Center, you must start the RoleTailored client for Windows in 
configuration mode. This is described later in this module.  

Personalization 

The Order Processor Role Center can then be further personalized on a single 
computer to meet the needs of a person (end-user) who is performing the job as 
an order processor. This person can personalize the Role Center by:  

• Resizing columns. 

• Changing the contents of drop-down menus. 

• Customizing the navigation pane. 

• Adding or removing FactBoxes. 
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• Organizing items in the Quick Access pane. 

• Saving queries or filters. 

• Choosing columns in a list. 

Resetting Personalization and Configuration Changes 

Personalization changes that are made by end-users override configuration 
changes that are made by the administrator. The administrator can reset a Role 
Center to its default settings by deleting all entries in the personalization or 
configuration tables. 

• To clear the configuration table, open the Profile Card window, click 
Actions, and then select Clear Configured Pages. 

• To clear the personalization table, open the Profile Card window, 
click Actions, and then select Clear Personalized Pages. 

RoleTailored Client 

With the RoleTailored client, you can create new and modify existing users, 
profiles, and permission sets (which determine access to specific objects).  

After you have created users and assigned them to permission sets, you can add 
users to profiles. This aligns them with Role Centers in the RoleTailored client.  

RoleTailored client users can be managed from the Users page. To access this 
page, click the Departments page and then click Administration > IT 
Administration > General > Users. You can also use this page to link permission 
sets to users.  

Permission sets can be administered from the Permission Sets page. To access 
this page, click the Departments page and then click Administration > IT 
Administration > General > Permission Sets. 

To create new profiles or edit existing profiles, you can use the Profiles page. To 
access this page, click the Departments page and then click Administration > 
Application Setup > RoleTailored Client > Profiles. 

    Note: You can also open the Users page by typing “Users” in the Search box 
on your home page in the RoleTailored client and then pressing Return.   
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Demonstration:  Create a User for Windows 
Authentication 

Demonstration Steps 

1. Open the Users page. 

a. Start the RoleTailored client. 
b. On the Departments page, click Administration > IT 

Administration > General > Users. 
 

2. Create a new user. 
a. On the Users page, click New. 
b. In the User Name field, type a unique, short name to identify the 

user. 

c. In the Full Name field, type the user’s full name (first name, last 
name). 
 

3. Specify the credential type. 
a. In the Windows User Name field, either type the name of a valid 

Active Directory user, by using the format domain\username, or 
click Assist. 

b. Click Allow for this client session, and then use the Select User 
or Group box to identify a Windows user. 
 

4. Add more user information. 

a. Add any notes or links for the user in the respective FactBoxes on 
the right side of the New – Users Card page.  

b. Click OK. 

Demonstration:  Create a User for Username 
Authentication 

Demonstration Steps 

1. Open the Users page. 
a. Start the RoleTailored client. 
b. On the Departments page, click Administration, click IT 

Administration, click General, and then click Users. 
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2. Create a new user. 
a. On the Users page, click New. 

b. In the User Name field, type a unique, short name to identify the 
user. 

c. In the Full Name field, type the user’s full name (first name, last 
name). 
 

3. Specify the credential type. 
a. In the Windows User Name field, either type the name of a valid 

Active Directory user, by using the format domain\username, or 
click Assist, and then click Allow for this client session. Use the 
Select User or Group box to identify a Windows user. 

b. In the State field, specify whether the user should at first be 
Enabled or Disabled. 

c. To set a time limit on the user’s access, enter a date in the Expiry 
Date field. 

d. Click Set Password and enter a password for the user. The first 
time that the user logs on, the system prompts him or her to 
change the password. 

e. Click OK to exit the Set Password box and return to the New – 
Users Card page. 
 

4. Add more user information. 
a. Add any notes or links for the user in the respective FactBoxes on 

the right side of the New – Users Card page.  

b. Click OK. 

Demonstration:  Create a User for NavUser Authentication 

Demonstration Steps 

1. Open the Users page. 

a. Start the RoleTailored client. 
b. On the Departments page, click Administration, click IT 

Administration, click General, and then click Users. 
 

2. Create a new user. 
a. On the Users page, click New. 
b. In the User Name field, type a unique, short name to identify the 

user. 

c. In the Full Name field, type the user’s full name (first name, last 
name). 
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3. Specify the credential type. 
a. In the Windows User Name field, either type the name of a valid 

Active Directory user, by using the format domain\username, or 
click Assist. Then click Allow for this client sesion, and then use 
the Select User or Group box to identify a Windows user. 

b. In the State field, specify whether the user should be Enabled or 
Disabled at first. 

c. To set a time limit on the user’s access, enter a date in the Expiry 
Date field. 

d. Click Set Password, and enter a password for the user. The first 
time that the user logs on, the system prompts him or her to 
change the password. 

e. Click OK to exit the Set Password box and return to the New – 
Users Card page. 
 

4. Add additional user information. 
a. Add any notes or links for the user in the respective FactBoxes on 

the right side of the New – Users Card page.  

b. Click OK. 

Demonstration:  Create a User for ACS Authentication 

Demonstration Steps 

1. Open the Users page. 

a. Start the RoleTailored client. 
b. On the Departments page, click Administration, click IT 

Administration, click General, and then click Users. 
 

2. Create a new user. 
a. On the Users page, click New. 
b. In the User Name field, type a unique, short name to identify the 

user. 
c. In the Full Name field, type the user’s full name (first name, last 

name). 
 

3. Specify the credential type. 
a. In the License Type field, choose one of the available license 

types.  
b. In the State field, specify whether the user’s access should be 

Enabled or Disabled. 
c. If you want to set a time limit on the user’s access, choose a date 

in the Expiry Date field.  

Microsoft Official Training Materials for Microsoft Dynamics ® 
Your use of this content is subject to your current services agreement 

 



Module 3: Microsoft Dynamics NAV Server 

3 - 21 

d. In the Authentication section, next to ACS Access Status, click on 
the word Disabled, or select the word and press Enter. This 
opens an Edit -User ACS Setup dialog box.  

e. In the Edit -User ACS Setup dialog box, click Generate Auth 
Key on the ribbon. A string value is automatically inserted into 
the Authentication Key field.  

f. Save the Authentication Key value to a text file or another 
location where you can find it later. After you configure your 
deployment for ACS, and configure your Microsoft Dynamics 
NAV components for ACS, send this value, along with the User 
Name value, to the actual user and direct the user to provide 
these values when logging on with a Microsoft Dynamics NAV 
client.  

g. Click OK to exit the Edit -User ACS Setup dialog box.  

The ACS Access Status is now Pending. It will change to Active 
after the user successfully logs in. 

4. Add additional user information. 
a. Add any notes or links for the user in the respective FactBoxes on 

the right side of the New – Users Card page.  
b. Click OK. 

Demonstration:  Edit or Create a Permission Set 

If the default permission sets that are provided with the RoleTailored client for 
Windows are insufficient or unsuitable for your organization, then you can create 
new permission sets.  

If the individual object permissions that define a permission set are not suitable, 
then you can edit a permission set 

Demonstration Steps 

1. Create a permission set. 
a. Start the RoleTailored client for Windows. Or, you can type 

“Permission Sets” in the Search box on your home page, and 
then click Permission Sets in the Results list. The Permission Sets 
page opens. 

b. On the Permission Sets page, click New. The New – Permission 
Sets page opens.  

c. Type a name for the new permission set in the Permission Set 
field and a brief description for the new permission set in the 
Name field.  

d. The name of the new permission set is automatically formatted in 
all uppercase letters. 
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e. Click Permissions to open the Edit - Permissions page.  
f. Type or select an object type on the first line in the list.  If you 

would prefer to select from a list that shows all database objects, 
instead of typing or selecting objects, click All Permissions.  

g. Type or select an Object ID.  
h. Click in the Object Name field to display the default name for 

the object.  
i. Type or select the word “Yes” for all permissions (Read 

Permission, Insert permission, Modify permission and Delete 
permission, but not Execute permission) that you are including in 
this permission set. You can also assign a value of Indirect. For 
more information, see the Indirect Permission section, in this 
module.  

j. Create any security filters that you want to apply to the 
permissions that you have assigned to the permission set.  

k. To include permissions for additional objects, position the cursor 
on a new line in the list and repeat steps f through j.  

l. When the permission set is complete, click OK to exit the Edit – 
Permissions page. 
 

2. Edit a permission set. 

a. In the Search box on your home page in the RoleTailored client 
for Windows, type “Permission Sets” and then click Permission 
Sets in the Results list. The Permission Sets page opens. 

b. On the Permission Sets page, click Actions, and then click Edit 
List. The Edit – Permission Sets page opens. 

c. Select a permission, and then click Permissions to open the Edit 
- Permissions page for the selected permission set. 
Each row in the list defines the permissions for one of the objects 
included in the permission set definition. 

d. Select an existing object to modify its permissions, or scroll to the 
end of the list and position the cursor on a new line to add an 
additional object to the permission set definition.  

e. If you are adding an object to the permission set definition, type 
or select an Object ID. If you would prefer to select from list that 
shows all database objects, instead of typing or selecting objects, 
click All Permissions.  

f. If you are adding an object to the permission set definition, click 
in the Object Name field to display the default name for the 
object.  

g. Type or select the word “Yes” for all permissions that you are 
including in this permission set.  
You can also assign a value of Indirect. 
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h. Create any security filters that you want to apply to the 
permissions that you have assigned to the permission set.  

i. Continue modifying objects or adding new objects to the list until 
the definition is completed.  

j. Click OK to exit the Edit – Permissions page. 

Demonstration:  Assign a User to a Permission Set 

Microsoft Dynamics NAV 2013 provides a set of standard permission sets. A 
permission set is a collection of permissions for specific objects in the database. All 
users must be assigned one or more permission sets before they can use the 
RoleTailored client.  

By default, several predefined permission sets are provided in the RoleTailored 
client. You can use these permission sets as already defined, modify the default 
permission sets, or create additional permission sets. 

A table can contain a FlowField that generates sums based on values that are 
stored in another table. In this case, users must have permission to read both 
tables or they cannot read the first table. 

Demonstration Steps 

1. Assign a user to a permission set.  

a. In the Search box on your home page in the RoleTailored client 
for Windows, type “Users” and then click Users in the Results list. 
The Users page opens.  

b. Select a user, and then click Permissions. 
The Edit – User Permissions page opens. Any permission sets 
that are already assigned to the user are displayed. 

c. To assign a new permission set to the user, click to position the 
cursor on a blank line and then click Assist to display a list of 
existing permission sets.  

d. Click to select a permission set. You cannot select more than one 
permission set at a time. However, you can repeat the step to 
assign multiple permission sets to the user. 
If there is more than one company in your database, you can type 
or select a company in the Company column to restrict these 
permissions to that company. If you leave this column blank, the 
user will have the relevant permissions for the whole database. 

e. Click OK to exit the Edit – <username> page. 
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Demonstration:  Create or Edit a Profile 

You use the Profile card to create profiles for end-users. Each profile is associated 
with a Role Center. Profiles are typically based on job titles in a company.  

The procedure for modifying an existing profile is the same, except you select an 
existing profile in the Profiles page instead of clicking New (step 3). 

Demonstration Steps 

a. In the RoleTailored client for Windows, click Departments, click 
Administration, click RoleTailored Client, and then click 
Profiles.   

b. In the ribbon, click New to open the New Profile Card window.  

c. In the Profile ID field, type a name that describes the intended 
role of the user. 

d. In the Owner ID field, click AssistEdit to view all available logins, 
and then select a Windows user.  

e. In the Description field, type a description of the Profile ID, for 
example, "Order Processor".  

f. In the Role Center ID field, click AssistEdit to view all available 
Role Centers. Then select a Role Center.  

g. To make this Role Center the default for the profile, select Default 
Role Center.   

h. Click OK to save your changes. 

Demonstration:  Assign a User to a Profile 

You use the User Personalization window in the RoleTailored client for Windows 
to assign a user to a profile. 

Demonstration Steps 

1. Assign a user to a profile. 

a. In the RoleTailored client for Windows, click Departments, click 
Administration, and then click RoleTailored Client.  

b. Click User Personalization to open the User Personalization Card 
window.  

c. In the User ID field, click AssistEdit to view all available user 
logins.  

d. Select a user logon, and then click OK.  

e. In the Profile ID field, select a profile ID that you have already 
created. Click AssistEdit to view all available profiles.  

f. In the Language ID field, select the appropriate language ID, or 
leave this field blank. 
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g. In the Company field, select a company from the Companies 
window.  

h. Click OK. 

Development Environment 

You use the Development Environment to create and manage Microsoft Dynamics 
NAV 2013 databases, to create and manage Microsoft Dynamics NAV companies, 
and to upload or change Microsoft Dynamics NAV licenses. 

In addition, the Development Environment enables you to open the Object 
Designer, which gives you access to Microsoft Dynamics NAV objects. Use the 
Development Environment to modify the application or to create new application 
areas. For more information about this topic, see the C/SIDE Introduction training 
manual. 

The Development Environment is a subcomponent of the RoleTailored client for 
Windows and is automatically installed as part of the Install Demo and 
Developer installation options. It can also be installed as part of the Client and 
Custom Component options.  

The following figure shows the Development Environment user interface.  

 

FIGURE 3.2: THE MICROSOFT DYNAMICS NAV 2013 DEVELOPMENT 
ENVIRONMENT WINDOW 
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Although you can install the RoleTailored client for Windows without the 
development environment, you cannot install the Development Environment 
component without the RoleTailored client for Windows.  

The user interface of the Development Environment is only visible to 
administrators and can only be used for administrative tasks. It is not visible to the 
RoleTailored client users. Like the RoleTailored client for Windows, you can 
change the language of the user interface of the development environment. 
However, some of the functionalities (more in specific the C/SIDE design 
functions) in the development environment are available only in English.  

To open the Development Environment, click Start > All Programs > Microsoft 
Dynamics NAV 2013 Development Environment. On startup, the Development 
Environment shows the Object Designer.  

Unlike the RoleTailored client, the Development Environment will connect directly 
to a Microsoft Dynamics NAV SQL Server database. You can connect to different 
databases without having to restart other core components.  

When you upgrade a RoleTailored client environment to Microsoft Dynamics NAV 
2013, you will have to use the Development Environment to upgrade the existing 
Microsoft Dynamics NAV SQL Server database to the latest version. 

Please be aware that managing databases, companies, objects, and licenses 
requires the necessary permissions on SQL Server. These permissions can be 
granted by using SQL Server Management Studio.  

Permissions for Managing Databases 

For an administrator to create new Microsoft Dynamics NAV databases in 
Microsoft Dynamics NAV Development Environment, that administrator must 
have the dbcreator and securityadmin Server Roles for the instance of SQL Server 
running Microsoft Dynamics NAV. 

    Note: The administrator must also have a Microsoft Dynamics NAV 
developer’s license to use the Development Environment and be assigned the 
SUPER permission set.  

In the Object Explorer pane in SQL Server Management Studio, follow these 
steps after you connect to the instance of Microsoft Dynamics NAV SQL Server: 

1. Expand the Security node, right-click Logins, and select New Login.  
If the administrator already has a Login, right-click the user and select 
Properties. Then go to step 4. 

2. In the Login – New box, select Search. 
3. In the Select User or Group box, select a valid Active Directory user. 
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4. In the Login – New box, under Select a Page, select Server Roles. 
Select the dbcreator and securityadmin check boxes. 

5. Click OK to close the Login – New box. 

When administrators create Microsoft Dynamics NAV databases in the Microsoft 
Dynamics NAV Development Environment, the account running Microsoft 
Dynamics NAV Server is automatically granted the db_owner database role for 
these databases. 

Permissions for Managing Companies, Objects, and Licenses 

Administrators who create Microsoft Dynamics NAV databases automatically have 
permission to manage companies, objects, and licenses in that database.  

To grant permission to manage companies, objects, and licenses in Microsoft 
Dynamics NAV Development Environment to additional administrators, assign 
those administrators the db_owner database role for all relevant Microsoft 
Dynamics NAV databases. 

To grant the db_owner role on a Microsoft Dynamics NAV database in SQL Server 
Management Studio, follow these steps: 

1. If the administrator is not already a SQL Server login, add the 
administrator as a login by following the first three steps in the 
procedure above.  

2. Select the Microsoft Dynamics NAV database, then Security, then 
right-click Users and select New User. 
Select the button at the right side of the Login Name field to open 
the Select Login box. 

3. Select the check box for the relevant Login and then click OK. 

4. Click OK to exit the Select Login box. 
5. Enter a User name for the user. This can be the same as the login 

name. 
6. In the Database role membership list at on the Membership page, 

select the db_owner check box. 
7. Click OK to exit the Database User – New box. 
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License File Management 

After an administrator or a Microsoft Certified Partner installs Microsoft Dynamics 
NAV, upload the license file that is supplied by Microsoft. 

At first, Microsoft Dynamics NAV uses CRONUS.flf, which is the demonstration 
license file. All license files that are not demonstration license files are named 
FIN.flf. The demonstration license file has a different name so that it cannot be 
mistakenly overwritten. 

The license file must be uploaded to SQL Server by using the Microsoft Dynamics 
NAV Development Environment. You can upload a license file either for all 
databases on an instance of SQL Server or for a specific database only.  

Please be aware that on a computer that is running any version of Windows with 
User Access Control enabled, you must start the Development Environment with 
administrator user rights. Click Start, right-click Microsoft Dynamics NAV 
Development Environment, and then click Run as administrator.   

The following procedure describes how to upload the license file to SQL Server: 

1. Start the Development Environment. 
2. Verify that you are connected to your database. On the File menu, 

point to Database, and then click Open.  
3. On the Tools menu, click License Information. 
4. In the License Information window, click Upload. 

5. In the Upload License File box, browse to and open the license file. 
You should see the following message: The Server license was 
successfully uploaded.  

6. Restart the Development Environment to enable the license if you will 
use it to work in the Development Environment. 

To upload the license file to a specific database, follow these steps: 

1. In the Development Environment, on the File menu, point to 
Database, and then click Alter. 

2. In the Alter Database window, click Integration, and then click Save 
license in database. 

3. Click OK. 
4. In the Upload License File box, select the Microsoft Dynamics NAV 

license file, and then click Open. 
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FIGURE 3.3: UPLOADING THE LICENSE FOR A SPECIFIC DATABASE 

To save the license file in the database, you must have the Per Database license 
granule (2020) in your license. You must also have the necessary roles and 
permissions in SQL Server, as described earlier in this lesson.  

Database Management 

The Microsoft Dynamics NAV Development Environment enables you to maintain 
Microsoft Dynamics NAV databases. It can be used for the following tasks: 

• Create a new database. 

• Alter existing databases. 

• Test databases. 

• Delete databases. 

• Increase the size of database files. 

• Add new database files. 

• Increase the size of the transaction log files. 

• Add new transaction log files. 

• Test tables in a database. 

Databases can be managed from the Database menu (which is under the File 
menu).  
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NAV Server Administration Tool 

The Microsoft Dynamics NAV Server Administration tool is a Microsoft 
Management Console (MMC) snap-in for creating and managing Microsoft 
Dynamics NAV Server instances. When you install the Server option on a 
computer, Microsoft Dynamics NAV Server Administration tool is one of the 
default features. Microsoft Dynamics NAV Server Administration tool is also an 
option when you install the Client option, although it is not one of the default 
components.  

    Note: Only members of the Administrator group on the computer can use the 
Microsoft Dynamics NAV Server Administration tool.  

The NAV Server Administration tool can be used to perform the following tasks: 

• Create a Microsoft Dynamics NAV Server instance. 

• Manage Microsoft Dynamics NAV Server instances. 

• Manage settings for a Microsoft Dynamics NAV Server instance. 

• Administer a remote Microsoft Dynamics NAV Server. 

• Administer multiple Microsoft Dynamics NAV Server computers from 
a single administrative console. 

The NAV Server Administration tool can be run in two ways: 

• From the Windows Start menu. 

• From the Microsoft Management Console (MMC). 

Although Microsoft Dynamics NAV Server will run on Windows Server 2008, the 
Microsoft Dynamics NAV Server Administration tool will only run on Windows 
Server 2008 R2. 

Running the Server Administration Tool from the Windows Start 
menu 

To start the tool, on the Windows taskbar, click Start > All Programs > Microsoft 
Dynamics NAV Administration. 

    Note: Alternatively, you can click Start, and in the Search programs and 
files box, enter Microsoft Dynamics NAV Administration, and then click the 
related link.  
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The following figure shows the Microsoft Dynamics NAV Server Administration 
tool started from Windows Start menu: 

 

FIGURE 3.4: THE MICROSOFT DYNAMICS NAV SERVER ADMINISTRATION TOOL STARTED FROM 
WINDOWS START MENU 

Microsoft Dynamics NAV Server Administration tool is divided into three panes: 

• The left pane shows a tree view that lists all Microsoft Dynamics NAV 
Server computers that you are administering from this computer and 
all Microsoft Dynamics NAV Server instances on those computers. The 
first time that you run Microsoft Dynamics NAV Server Administration 
tool, the view is collapsed. You only see the local server without any 
Microsoft Dynamics NAV Server instances listed. To display any 
instances on the server,  you can click the triangle to the left of the 
local computer. Next, you can right-click the default instance to 
display settings for that instance in the center pane. 

• The center pane shows information about the item that you have 
selected in the left pane. When the selected item is a computer that is 
running Microsoft Dynamics NAV Server, the center pane shows a list 
of Microsoft Dynamics NAV Server instances on that computer and 
the status of each instance (running or stopped), and the name of the 
account under which the instance is running. When the item selected 
in the left pane is a Microsoft Dynamics NAV Server instance, the 
center pane shows the settings for that instance.  

• The right pane displays available actions for the object that is selected 
in the left pane. These options differ, depending on whether a 
Microsoft Dynamics NAV Server or a Microsoft Dynamics NAV Server 
instance is selected. For more information, see Administration Tool 
Actions. 
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Remember that if you start Microsoft Dynamics NAV Server Administration tool 
from the Windows Start menu, you can only connect to a single Microsoft 
Dynamics NAV Server at a time. (This can be either the local or a remote Microsoft 
Dynamics NAV Server.)  

If you start the tool from MMC, you can administer multiple Microsoft Dynamics 
NAV Server computers from a single instance of Microsoft Dynamics NAV Server 
Administration tool. This is described next. 

Running the Server Administration Tool from MMC 

The following procedure describes how to start the tool from Microsoft 
Management Console (MMC) and to connect to the local Microsoft Dynamics 
NAV Server. 

1. On the local Microsoft Dynamics NAV Server, click Start > Run, and 
then enter the following command: 

mmc 

2. In the management console window, on the File menu, click 
Add/Remove Snap-in to open the Add or remove Snap-ins box. 

3. In the Available snap-ins list, double-click Microsoft Dynamics NAV. 

4. In the Connect to another computer box, in the Server Name box, 
type the name of the local Microsoft Dynamics NAV Server, and then 
click OK.  You can also accept the default value, which is (Local).  

5. Click OK. 
6. Click OK to close the Add or remove Snap-ins box.  
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Now you see the single (local) Microsoft Dynamics NAV Server is listed in the tree 
view pane of Microsoft Dynamics NAV Server Administration tool: 

 

FIGURE 3.5: THE MICROSOFT DYNAMICS NAV SERVER ADMINISTRATION TOOL STARTED FROM 
MMC 

When you close MMC, you are prompted to save your settings to a Microsoft 
Management Console (.msc) file. If you save your settings (for example to the 
Windows Desktop), then you can use this file to open MMC with the Microsoft 
Dynamics NAV Server already listed. 

Connecting to Multiple Microsoft Dynamics NAV Server Computers 

To administer multiple Microsoft Dynamics NAV Server computers from a single 
instance of the Server Administration tool, you have to start the tool from MMC. 
However, before you can connect to and manage remote Microsoft Dynamics 
NAV Server computers, you have to enable remote administration on each remote 
server that you want to manage from the Microsoft Dynamics NAV Server 
Administration tool. 

The following procedure describes how to enable the remote Microsoft Dynamics 
NAV Server administration on a Microsoft Dynamics NAV Server. 

1. Verify that the administrator who will be connecting to the remote 
computer is a member of that computer’s Administrators group. 

2. On the remote computer, open a Windows PowerShell™ command 
prompt with administrative credentials. Click Start > Accessories, 
right-click Windows PowerShell, and then click Run as administrator. 

3. Windows PowerShell is included in Windows 7 and Windows Server 
2008 R2 and can be installed on other Windows operating systems. 
For more information, see Windows PowerShell in the TechNet 
Library. 
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4. On each remote computer, at the Windows PowerShell command 
prompt, type "Enable-PSRemoting", and then answer Yes to all 
questions. 

Afterward you can configure MMC to connect to multiple Microsoft Dynamics 
NAV Server computers. To do this, follow these steps: 

1. On the local Microsoft Dynamics NAV Server, click Start > Run, and 
then enter the following command: 

mmc 

2. In the management console window, on the File menu, click 
Add/Remove Snap-in to open the Add or remove Snap-ins box. 

3. In the Available snap-ins list, double-click Microsoft Dynamics NAV. 
4. In the Connect to another computer box, type the name of the 

Microsoft Dynamics NAV Server That You want to administer in the 
Server Name box, and then click OK.  If you want to connect to the 
local Microsoft Dynamics NAV Server, you can either enter the name 
of the local computer or you can also accept the default value, which 
is (Local).  

5. Repeat steps 3 and 4 for each Microsoft Dynamics NAV Server That 
You want to administer. A computer can only be added once to the 
same Server Administration tool instance. 

6. Click OK to close the Add or remove Snap-ins box.  

Now you see multiple Microsoft Dynamics NAV Server computers listed in the tree 
view pane of Microsoft Dynamics NAV Server Administration tool: 

 

FIGURE 3.6: MICROSOFT DYNAMICS NAV SERVER ADMINISTRATION TOOL WITH 
MULTIPLE MICROSOFT DYNAMICS NAV SERVER COMPUTERS 
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Administration Tool Actions 

Microsoft Dynamics NAV Server Administration tool actions are tasks that are 
listed in the right pane of the tool. The actions that are available vary, depending 
on whether you have selected a Microsoft Dynamics NAV Server or a Microsoft 
Dynamics NAV Server instance in the left pane. 

Actions on Microsoft Dynamics NAV Server Computers 

You can perform these tasks when you select a Microsoft Dynamics NAV Server in 
the tree view pane. 

Action Comment 

Connect to Another 
Computer 

With this action, you can connect to 
another Microsoft Dynamics NAV Server. 
When you select this option, the Connect 
to another computer box appears. In the 
box, type the name of the Microsoft 
Dynamics NAV Server That You want to 
administer in the Server Name box, and 
then click OK. 

Add Instance With this option, you can create additional 
server instances to a Microsoft Dynamics 
NAV Server. For more information, see 
Managing Server Instances later in this 
module.   

Actions on Microsoft Dynamics NAV Server Instances 

You can perform the following tasks when you select a Microsoft Dynamics NAV 
Server instance in the tree view pane. 

Action Comment 

Configuration When you select this option, you can view 
the configuration settings for the selected 
instance in the middle pane. To modify the 
settings, click Edit at the bottom of the 
middle pane. To save the modified settings, 
click Save. To discard the changes, click 
Cancel. When you change settings, you 
must restart the server instance. 

Login Account When you click Login Account, you see 
information about the login account for 
the Microsoft Dynamics NAV Server 
instance. To modify this information, click 
Edit. 
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After you modify either the configuration or login account settings, you must 
restart the Microsoft Dynamics NAV Server instance for these changes to take 
effect. Follow these steps: 

1. Select a Microsoft Dynamics NAV Server in the tree view pane. 
2. In the center pane, under Server Instance, right-click the instance you 

have modified. 

3. From the list, click Restart or click Start if the instance is not already 
running. 

You can perform the following tasks when you select a Microsoft Dynamics NAV 
Server instance in the middle pane.  

Action Comment 

Remove This removes the selected server instance 
(and the underlying Windows service).  

Restart/Start The Restart action stops and starts a 
running service. The Start action starts a 
stopped server instance.  

Stop This option stops a running server instance. 

Server Instance Management 

When you install Microsoft Dynamics NAV Server on a computer, there is at first a 
single default instance. The default instance is identified as Microsoft Dynamics 
NAV Server. If your organization requires additional instances, then you can either 
install Microsoft Dynamics NAV Server on additional computers or create 
additional instances on the original Microsoft Dynamics NAV Server.  

Each Microsoft Dynamics NAV Server instance on a computer runs as a separate 
Windows service and can run under a separate computer account, which is the 
Service account. 

You can use the Server Administration tool to manage existing server instances 
and create new instances.  

Server Instance Creation 

The following procedure describes how you can create a new server instance on 
the local Microsoft Dynamics NAV Server.  

1. Open the Microsoft Dynamics NAV Server Administration tool. Click 
Start > All Programs > Microsoft Dynamics NAV Administration.  
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2. In the tree view, which is the left pane, select the Microsoft Dynamics 
NAV Server where you want to add an instance. This is typically the 
local computer, which is Microsoft Dynamics NAV 7 (local). For more 
information about remote administration, see Running the Server 
Administration Tool from MMC and Administration Tool Actions. 

3. Right-click the computer name, and then click Add Instance. 

4. Supply the required values in the Server instance settings section 
for the new instance.  
Each instance on a computer must have unique values for these 
settings. 

Parameter Description 

Server Instance Enter a unique name for the server 
instance. 

Management Services 
Port 

Enter the number of the listening port for 
remote management instructions. 

Client Services Port Enter the number of the listening port for 
RoleTailored client for Windows 
connections. 

SOAP Services Port Enter the number of the listening port for 
SOAP web services connections. 

OData Services Port Enter the number of the listening port for 
OData web services connections. 

Remember that you have to specify a value for all service types (Client, SOAP, 
OData, and Management), even if you want to create a server instance for specific 
service types only. 

5. Supply the required values in the Log on Account section, and then 
specify the computer account that will run the instance in the Service 
Account field. You can select the Network Service account or a 
domain user account. If you select Network Service in the Service 
Account field, then you do not have to specify values for the User 
name, Domain, and Password fields. 
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Parameter Description 

Service Account Select the account type under which the server 
instance will run. You can select either Network 
Service or User Account. 

User Name Enter the user name of the Windows account 
under which the server instance will run.   

Domain Enter the domain name of the Windows 
account under which the server instance will 
run.  

Password Enter the password of the Windows account 
under which the server instance will run.  

Confirm Password Confirm the password of the Windows account 
under which the server instance will run.  

6. Click OK to close the Server Instance window. 

    Note: Using the Network Service account to run a Microsoft Dynamics NAV 
Server instance is considered less secure because this account is a shared account 
that can be used by other unrelated network services. Any user who has rights to 
the Network Service account also has rights to other services that are running on 
this account. Running Microsoft Dynamics NAV Server instances under a dedicated 
domain user account, which is an account that is used only for Microsoft Dynamics 
NAV components, can be more secure but requires a domain administrator to set 
up and provision the account.  

When you create additional server instances on a Microsoft Dynamics NAV Server, 
a subfolder will be created under C:\Program Files\Microsoft Dynamics 
NAV\70\Service\Instances\ for each instance. This subfolder will have the same 
name as the server instance and will contain the CustomSettings.config file for the 
server instance. 

After you have created a new server instance, you can also configure it using the 
Microsoft Dynamics NAV Server Administration tool.  
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Server Instance Configuration 

After you have installed a Microsoft Dynamics NAV Server instance, you can use 
the Server Administration tool to (re)configure the settings for the server instance. 
To change these settings, start the Microsoft Dynamics NAV Server Administration 
tool, connect to the server that you want to administer, and then select the server 
instance to configure.  

The following table shows the parameters that you can change:  

Tab Parameter Description 

General Database Instance The name of the SQL Server database 
instance to connect to. If this setting is a 
null string (“”), Microsoft Dynamics NAV 
Server connects to the default instance 
of SQL Server. 
Default: NAVDEMO 

 Database Name The name of the SQL Server database. 
Default: "Demo Database NAV (7-0)" 

 Database Server A valid network name for the computer 
that is running SQL Server. 

 Data Cache Size The contextual size of the data cache.  
Default: 6 

 Debugging Allowed Specifies whether C/AL debugging is 
allowed for this Microsoft Dynamics 
NAV Server instance. 

Default: Enabled 

 Enable Debugging Specifies whether the Microsoft 
Dynamics NAV Server instance starts 
with debugging enabled.  
If this option is enabled, the following 
occurs:  
• When the RoleTailored client for 

Windows first connects, all C# files 
for the application are generated. 

• C# files persist between Microsoft 
Dynamics NAV Server restarts. 

• Application objects are compiled 
with debug information. 

Default: Not enabled 
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Tab Parameter Description 

 Enable Software 
Quality Metrics 

Specifies whether the Microsoft 
Dynamics NAV Server instance can 
collect basic information about your 
hardware configuration and how you 
use Microsoft Dynamics NAV Server. 
Then it sends it to Microsoft. Microsoft 
uses this information to identify trends 
and usage patterns and to improve its 
software. 
Default: Not enabled 

 Max Concurrent 
Calls 

The maximum number of concurrent 
client calls that can be active on this 
Microsoft Dynamics NAV Server 
instance. 
Default: 40 
Range: 1 - 2,147,483,647 
You can also use MaxValue as a value to 
indicate no limit. 

 Metadata Provider 
Cache Size 

The number of objects that can be 
cached. Set this value to 0 to disable 
caching. 
Default: 150 

 Network Protocol The network protocol for accessing the 
database. 
Valid values: Default, NamedPipes, 
Sockets, MultiProtocol. 
Default: Default 

 Server Instance 
Name 

The name of the Microsoft Dynamics 
NAV Server instance. 
Default: DynamicsNAV70 

Microsoft Official Training Materials for Microsoft Dynamics ® 
Your use of this content is subject to your current services agreement 

 



Module 3: Microsoft Dynamics NAV Server 

3 - 41 

Tab Parameter Description 

 Services Default 
Time Zone 

The time zone in which web service and 
NAS services calls are run. 
Values:  

• UTC 
All business logic for web services 
and NAS services on the server 
instance runs in Coordinated 
Universal Time (UTC). This is how all 
web services business logic was 
handled in earlier versions. 

• Server Time Zone  

Services use the time zone of the 
computer that is running. Microsoft 
Dynamics NAV Server. 

• <ID of any time zone recognized by 
the current version of Windows> 

Specifies any Windows time zone as 
defined in the system registry under 
HKEY_LOCAL_MACHINE\SOFTWARE\M
icrosoft\Windows 
NT\CurrentVersion\Time Zones. For 
example, Romance Standard Time. 

 

Default: UTC 

 Session Event Table 
Purge Frequency 

The day of the week and the start time 
that the session event table will be 
queried for purging. The value of the 
DayOfWeek ranges from 0 (Sunday) to 
6. The value of Time should be a valid 
time of the day expressed in the format 
hh:mm. hh is hours measured on a 24-
hour clock, and mm is minutes. 

 Session Event Table 
Retain Period 

An integer value that specifies number 
of months the session events should be 
retained 

 SQL Command 
Timeout 

The contextual time-out for an SQL 
command. 

Default: 0:30:00 
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Tab Parameter Description 

Client Services Certificate 
Thumbprint 

Certificate thumbprint for those who 
use security certificates to protect 
communications between RoleTailored 
clients for Windows and Microsoft 
Dynamics NAV Server over an open or 
wide area network. You must provide 
the certificate thumbprint to Microsoft 
Dynamics NAV Server by updating this 
setting.  

 Enable Certificate 
Validation 

Specifies whether validation should be 
performed on the certificate. 
Default: Enabled 

 Chunk Size The default size for a chunk of data that 
is transferred between Microsoft 
Dynamics NAV Server and the 
RoleTailored client for Windows, in 
kilobytes. 

Default: 28. 
The range of values is from 4 to 80. 

 Compression 
Threshold 

The threshold in memory consumption 
at which Microsoft Dynamics NAV 
Server starts compressing datasets, in 
kilobytes. 

Default: 64 
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Tab Parameter Description 

 Credential Type How RoleTailored client for Windows 
users are authenticated when they 
connect to Microsoft Dynamics NAV 
Server. 
When set to Windows, Windows logon 
credentials are used, and users are not 
prompted for authentication 
information.  
When set to UserName, users are 
prompted for user name and password 
credentials. This setting is recommended 
for connecting RoleTailored clients for 
Windows over an open or wide area 
network that has communications 
protected with SSL.  
You must also configure the Client 
Credential Type setting in all 
RoleTailored client for Windows 
configuration files to match the value in 
the Microsoft Dynamics NAV Server 
configuration file. 

 Enable Client 
Services 

Specifies whether RoleTailored client for 
Windows services are enabled for this 
Microsoft Dynamics NAV Server 
instance. 

Default: Enabled 

 Idle Client Time-
Out 

The interval of time that a Microsoft 
Dynamics NAV Server client session can 
remain inactive before the session is 
dropped. 
Time interval format: [dd.]hh:mm:ss[.ff] 
Where:  

• dd: days 

• hh: hours 

• mm: minutes 

• ss: seconds 

• ff: hundredths of a second 

You can also use MaxValue as a value to 
indicate no time-out. This is the default 
value. 
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Tab Parameter Description 

 Max Concurrent 
Connections 

The maximum number of concurrent 
client connections that the current 
Microsoft Dynamics NAV Server instance 
accepts. 
Default: 150 
You can also use MaxValue as a value to 
indicate no limit. 

 Max Items in 
Object Graph 

The maximum number of objects to 
serialize or deserialize.  
Default: 512 

 Max Number of 
Orphaned 
Connections 

The maximum number of orphaned 
connections to be kept alive 
concurrently for the time that is 
specified by ClientReconnectPeriod. 
A connection is “orphaned” when the 
client is involuntarily disconnected from 
Microsoft Dynamics NAV Server. 

Default: 20 
You can also use MaxValue to indicate 
no limit. 

 Max Upload Size The maximum size of files that can be 
uploaded to or downloaded from 
Microsoft Dynamics NAV Server, in 
megabytes. Use this setting to avoid 
out-of-memory errors.  
Default: 5 

 Operation Time-
Out 

The maximum time that Microsoft 
Dynamics NAV Server can take to return 
a call from the client. 
Time span format: [dd.]hh:mm:ss[.ff] 

Where:  
• dd: days 

• hh: hours 

• mm: minutes 

• ss: seconds 

• ff: hundredths of a second 

You can also use MaxValue as to 
indicate no time-out. This is the default 
value. 
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Tab Parameter Description 

 Port The listening TCP port for RoleTailored 
clients for Windows. 
Default: 7046 

Valid range: 1 - 65535 

 Prohibited File 
Types 

A series of file name extensions, 
delimited by semicolons. Microsoft 
Dynamics NAV Server will not store files 
of any of the specified types when it is 
requested to do so by clients. 
Default: Many extensions—see 
Microsoft Dynamics NAV Server 
Administration tool for the complete list. 

 Protection Level The security services for protecting the 
data stream between RoleTailored 
clients for Windows and Microsoft 
Dynamics NAV Server.  
All RoleTailored clients for Windows that 
connect to the Microsoft Dynamics NAV 
Server instance must have the same 
ProtectionLevel value in their 
ClientUserSettings.config files.  
For background information on 
transport security, see Understanding 
Protection Level 
(http://go.microsoft.com/fwlink/?LinkId
=267422). 
Default: EncryptAndSign 
Values: EncryptAndSign, Sign, None 
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Tab Parameter Description 

 Reconnect Period The time a client can use to reconnect 
to a running instance of Microsoft 
Dynamics NAV Server.  

Time span format: [dd.]hh:mm:ss[.ff] 
Where:  
• dd: days 

• hh: hours 

• mm: minutes 

• ss: seconds 

• ff: hundredths of a second 

Default: 00:10:00 

You can also use MaxValue to indicate 
no time limit. 

SOAP Services Enable SOAP 
Services 

Specifies whether SOAP web services are 
enabled for this Microsoft Dynamics 
NAV Server instance. 
Default: Enabled 

 Max Message Size The maximum permitted size of a SOAP 
web services request, in kilobytes.  
Default: 1024 

 Port The listening HTTP port for Microsoft 
Dynamics NAV SOAP web services. 
Default: 7047 
Valid range: 1 - 65535 

 Enable SSL Specifies whether SSL (https) is enabled 
for the SOAP web service port. 
Default: Not enabled 

 Use NTLM 
Authentication 

Specifies whether NTLM authentication 
is enabled for SOAP web services. 
Enable this setting if you are using PHP 
or Java to start a web services 
connection to Microsoft Dynamics NAV.  
Default: Not enabled 

OData Services Default Company The default company that is used if the 
user has never used the Microsoft 
Dynamics NAV client. 
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Tab Parameter Description 

 Enable OData 
Services 

Specifies whether OData web services 
are enabled for this Microsoft Dynamics 
NAV Server instance. 

Default: Enabled 

 Max Page Size The maximum number of entities 
returned per page of OData results. See 
Server-Driven Paging in OData Web 
Services. 

 Port The listening HTTP port for Microsoft 
Dynamics NAV OData web services. 
Default: 7048 
Valid range: 1 - 65535 

 Enable SSL Specifies whether SSL (https) is enabled 
for the OData web service port. 

NAS Services Company The Microsoft Dynamics NAV company 
that opens when NAS services start. 

 Enable Debugging Specifies that the NAS services session 
wait 60 seconds before executing the 
first C/AL statement. This allows time for 
starting and attaching the NAV 
Debugger to the NAS services session. 
Default: Not enabled 

 Startup Argument • A string argument to be used when 
NAS services start. The argument 
typically specifies an application 
type, sometimes with additional 
configuration information.  

• Example values: 

• "ADCS, ADCSID=1"  

• "OSYNCH"  

• "JOBQUEUE" 
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Tab Parameter Description 

 Startup Codeunit The codeunit that contains the method 
that will be called by the NAS Startup 
Method setting. 

Example values: 
• 0  

When NASStartupCodeunit is set to 
0, NAS Services do not start. This is 
the default value. 

• 1  
When NAS services start they run 
the trigger specified by the NAS 
Startup Method in codeunit 1. 

• 450  

When NAS services start they run 
codeunit 450 (Job Queue – NAS Start 
Up), and call the method specified by 
NASStartupMethod. 

When the codeunit specified in this 
parameter is a single instance codeunit, 
the Microsoft Dynamics NAS service 
session will remain alive even after it 
runs all code in the specified NAS 
Startup Method. Information about 
single instance codeunits is covered in 
the course C/SIDE Introduction in 
Microsoft Dynamics NAV 2013. 
 

 Startup Method • The method that will be called in 
the NAS Startup Codeunit.  

• Example values:  

• “”  
If no start method is specified (null 
string), the OnRun trigger is called. 

• StartNAS  
NAS services runs the StartNAS 
method in the NAS Startup 
Codeunit. 
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Tab Parameter Description 

Management 
Services 

Enable 
Management 
Services 

Specifies whether Microsoft Dynamics 
NAV Server Administration tool is 
enabled for this Microsoft Dynamics 
NAV Server instance. 
Default: Enabled 

 Port The listening TCP port for Microsoft 
Dynamics NAV Server Administration 
tool. 
Default: 7045 
Valid range: 1 - 65535 

Remember that you must restart the Microsoft Dynamics NAV Server instance for 
the new settings to take effect.  

Powershell API 

Except the Microsoft Dynamics NAV Server Administration Tool, Microsoft 
Dynamics NAV 2013 also includes a command-line API for Server Administration. 
The API is implemented in Windows PowerShell 2.0. PowerShell 2.0 is included 
with Windows Server 2008 R2 and Windows 7. For other versions of Windows 
supported for Microsoft Dynamics NAV 2013, you can install it as part of the 
Windows Management Framework 
(http://go.microsoft.com/fwlink/?LinkId=267423). 

The PowerShell API enables you to manage licenses and server settings, to create 
and remove server instances and to manage users, and permission sets.  

To start a PowerShell administration session, click Start > All Programs > 
Microsoft Dynamics NAV 2013 PowerShell Session.  

The following figure shows a PowerShell prompt: 
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FIGURE 3.7: SERVER ADMINISTRATION WITH MICROSOFT DYNAMICS NAV 
POWERSHELL SESSION 

To then see the commands that are available for administering Microsoft 
Dynamics NAV, type the following command at the PowerShell prompt: 

Get-Command *NavServer* 

To get help on syntax and options for a specific command, type the following 
command: 

Get-help <cmd name> 

For example, to get Help about the Get-NAVServerInstance command, type the 
following: 

Get-help Get-NAVServerInstance 

For more information about the different PowerShell commands, see the 
“Microsoft Dynamics NAV PowerShell API” module.  

  

Microsoft Official Training Materials for Microsoft Dynamics ® 
Your use of this content is subject to your current services agreement 

 



Module 3: Microsoft Dynamics NAV Server 

3 - 51 

Wide Area Network Connections 
With Microsoft Dynamics NAV 2013 you can implement a secure RoleTailored 
client for Windows connection to Microsoft Dynamics NAV Server over a wide 
area network (WAN). In this deployment scenario, the RoleTailored client for 
Windows and Microsoft Dynamics NAV Server can be in the same or separate 
Active Directory domains. When you set up remote connections, use security 
certificates to protect your data.   

This lesson also discusses some performance benchmarks that you should consider 
before you implement a WAN connection. Finally it will describe how to 
implement security certificates in test and production environments. 

Deployment Scenario 

Microsoft Dynamics NAV 2013 not only supports multiple client types, it also 
enables you to implement a secure RoleTailored client for Windows connection to 
Microsoft Dynamics NAV Server over a wide area network (WAN).  

In this deployment scenario, the RoleTailored client for Windows and Microsoft 
Dynamics NAV Server can be in the same or separate Active Directory domains.  

The following illustration shows how a computer that is running the RoleTailored 
client for Windows in one Active Directory domain can connect to an instance of 
Microsoft Dynamics NAV Server in another domain. 

 

FIGURE 3.8: WIDE AREA NETWORK DEPLOYMENT SCENARIO 

In addition, implementations such as these assume the following: 

• All functionality is available to remote RoleTailored client for 
Windows users. 

• User accounts are provisioned in an Active Directory domain, and SQL 
Server and Microsoft Dynamics NAV Server are installed on a 
computer in this domain. 

• The administrator who is creating this implementation is a member of 
the Domain Admins group in this domain. 

Microsoft Official Training Materials for Microsoft Dynamics ® 
Your use of this content is subject to your current services agreement 

 



Installation and Configuration in Microsoft Dynamics® NAV 2013 

3 - 52 

• On the computer that is running Microsoft Dynamics NAV Server, a 
DNS entry that resolves to the published server port on the 
computer’s firewall exists for Microsoft Dynamics NAV Server. 

• If the RoleTailored client for Windows or Microsoft Dynamics NAV 
Server is behind a firewall, then you must have opened a port to 
communicate with Microsoft Dynamics NAV Server on the 
RoleTailored client for Windows computer and published the port on 
the Microsoft Dynamics NAV Server. The default port number is 7046. 

• The RoleTailored client for Windows and Microsoft Dynamics NAV 
Server are configured as described in the Walkthrough: Installing the 
Three Tiers on Three Computers topic in the MSDN Library 
http://go.microsoft.com/fwlink/?LinkId=267424. 

Certificates 

When you set up a remote access deployment, we strongly recommend that you 
protect your WAN connections with security certificates.   

You can use service certificates to help secure RoleTailored client for Windows 
connections over a wide area network (WAN). Microsoft Dynamics NAV 2013 can 
support the following configurations: 

• Chain trust, which specifies that each certificate must belong to a 
hierarchy of certificates that ends in a root authority at the top of the 
chain. 

• Peer trust, which specifies that both self-issued certificates and 
certificates in a trusted chain are accepted. 

This topic describes the chain trust configuration, which is the more secure option.  

In a production environment, you implement chain trust by obtaining X.509 
service certificates from a trusted provider. These certificates and their root 
certification authority (CA) certificates must be installed in the certificates store on 
the computer that is running Microsoft Dynamics NAV Server. The CA certificate 
must also be installed in the certificate store on computers that are running the 
RoleTailored client for Windows so that clients can validate the server. 

Implementing secured RoleTailored client for Windows connections over a Wide 
Area Network requires administration on both the Microsoft Dynamics NAV 
Server and the client computers. This module will describe how to configure the 
Microsoft Dynamics NAV Server to support logon over a WAN. Configuration of 
the RoleTailored client for Windows to support logon over a WAN is described in 
the next module.  

  

Microsoft Official Training Materials for Microsoft Dynamics ® 
Your use of this content is subject to your current services agreement 

 



Module 3: Microsoft Dynamics NAV Server 

3 - 53 

    Note: Implementing remote logon requires changing the credential type for 
the Microsoft Dynamics NAV Server instance involved. Consider using a dedicated 
Microsoft Dynamics NAV Server instance for remote connections so that this 
change does not affect local users. 

However, before you start deployment, you should determine whether users fit 
the performance profile for running the RoleTailored client for Windows over a 
WAN. 

Performance Considerations 

You can use the information in this section to help decide whether the 
RoleTailored client for Windows over WAN option is appropriate for your 
organization. Specifically, this section should help you answer the following 
questions: 

• Does your team's usage scenarios support running the RoleTailored 
client over a WAN? 

• What kind of performance can you expect when you run the 
RoleTailored client over a WAN? 

Targeted Usage Scenarios 

There are two primary scenarios for running the RoleTailored client for Windows 
over a WAN. 

• Mobile light users. Salespeople who visit customers, look up order 
histories, and take orders when at the customer site are examples of 
mobile light users. These users want quick and easy access to data to 
support their primary tasks. This usage is typically not extensive, and 
users prefer not to have to log on to the company network through a 
virtual private network. 

• Hosted users. Multiple users who sit at one location and access 
Microsoft Dynamics NAV Server at a remote location are hosted users. 
These users do not have control of the installation, which is managed 
by a hosting provider.  

For each scenario, the following assumptions are made: 

• Each user has a download speed of at least 1 megabit per second and 
an upload speed of at least 200 kilobits per second. 

• Network latency is less than 200 milliseconds. 
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• The RoleTailored client for Windows is running on a computer that 
cannot log on to an Active Directory domain controller, either in the 
domain where the RoleTailored client for Windows is installed or in 
the domain where Microsoft Dynamics NAV Server is installed. The 
RoleTailored client for Windows and Microsoft Dynamics NAV Server 
can be in the same Active Directory domain or in separate domains. 

Performance Testing Results 

Performance testing of these scenarios focused on latency and bandwidth. An 
environment where both latency and bandwidth could be throttled helped 
simulate different types of connectivity. The tests were based on 10 concurrent 
users posting 10 automated one-line sales orders with the RoleTailored client for 
Windows. This kind of measurement is not completely realistic because the order 
entry is so fast that the screen cannot render before Post is pressed. Therefore, if 
this is the benchmark load, then any real-life loads that involve similar operations 
will be slower. 

Bandwidth that ranged from a 10-megabit download and 1-megabit upload 
connection to a 300-megabit download and 300-megabit upload connection, 
which is comparable to a local area network, was tested.  

Latencies that ranged from 0 to 600 milliseconds were also tested. This range 
approximates connections from a fast LAN connection to a slow ADSL connection. 
The range also approximates a fast satellite connection. This would be between 
500 and 1000 milliseconds. 

In the Throughput/Latency graph, the x-axis from left to right shows the round-
trip time added to the connection in milliseconds. The line that runs from the 
lower-left to the upper-right shows the latency, or response times. The other lines 
show the maximum kilobytes received per second, average kilobytes received per 
second, maximum kilobytes sent per second, and the average kilobytes sent per 
second. 
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FIGURE 3.9: THROUGHPUT/LATENCY TESTS FOR WAN CONNECTIONS 

The graph shows that latency linearly affects the response time. It also shows that 
a larger latency affects the ability to use the available bandwidth and that the 
"elbow" or optimum latency is between a latency of 100 and 150 milliseconds. 

In the Bandwidth per User graph, the x-axis shows bandwidth per user, and the y-
axis shows the response time for the 10 sales orders. On the bandwidth per user 
axis, 5/1 represents a 50-megabit upload and 10-megabit download connection, 
and 2/0.5 represents a 20-megabit download and 0.5 megabit upload connection. 

 

FIGURE 3.10: BANDWIDTH PER USER WINDOW 

The graph shows that the "elbow" or optimal bandwidth is between 1.50/0.3 
megabits and 2/0.1. Additional tests show that the determining factor for these 
connections is the upload speed instead of download speed, and that the elbow is 
between 0.1 and 0.3 megabits per user for the tested scenarios. 
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Because these tests targeted limited bandwidth scenarios, you can also have a 
single session use all available bandwidth for any kind of connection when you 
transfer a large file or run a large report. 

    Note: The term Secure Sockets Layer (SSL) is not used in this topic to describe 
the implementations. Although these implementations do use the public and private 
key infrastructure of SSL and SSL certificates, they use Windows Communication 
Foundation (WCF) transport-level security (TLS) over the TCP/IP protocol instead of 
https. This means that they are not strict SSL implementations. 

Demonstration:  Implement Security Certificates in a Test 
Environment 

In this demonstration you set up an environment to test integrating certificates 
into a configuration for connecting computers that are running the RoleTailored 
client for Windows to Microsoft Dynamics NAV Server instances over a wide area 
network (WAN) with the chain trust configuration. 

Prerequisites 

To complete this demonstration, you will need: 

• The Certificates snap-in for Microsoft Management Console (MMC). If 
you do not already have this snap-in installed, then follow these steps: 

o Click Start > Run, and then type "Mmc.exe". 

o In the console, on the File menu, click Add/Remove Snap-in. 

o In the Add Standalone Snap-in box, select Certificates > 
Computer Account > Local Computer > Add. 
 

• The makecert.exe utility. For more information, see Certificate 
Creation Tool (Makecert.exe) in the MSDN Library 
(http://msdn.microsoft.com/en-us/library/bfsktky3.aspx). 

Microsoft Dynamics NAV Server Configuration 

You create and install a root certification authority (CA) and a server certificate on 
the computer that is running Microsoft Dynamics NAV Server. Next, you create a 
certificate revocation list for the root certification authority and then install the 
certificate revocation list on the computer that is running Microsoft Dynamics 
NAV Server. (A certificate revocation list is required because WCF applications 
check the revocation list when validating certificates.) After that, you create and 
install the test certificate for the Microsoft Dynamics NAV Server service and you 
grant the Microsoft Dynamics NAV Server service account access to the 
certificate’s private key. Finally, you will reconfigure Microsoft Dynamics NAV 
Server to support remote logon. 
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Demonstration Steps 

1. Create a root CA and a private key file by using the makecert.exe 
utility. 
a. Create a temporary folder to use when you work with certificates.  
b. Click Start > All Programs > Microsoft Visual Studio 2010 > 

Visual Studio Tools.  
c. Right-click Visual Studio Command Prompt (2010), and then 

click Run as administrator.  
d. At the command prompt, locate the temporary directory. 

e. Type the following command:  

makecert -n "CN=RootNavServiceCA" -r -sv RootNavServiceCA.pvk 
RootNavServiceCA.cer 

f. When you are prompted, enter a strong password.  
In this example, type "Pa$$w0rd". 
(You must have this password to create the service certificate.) 

The RootNavServiceCA.cer certificate file and the 
RootNavServiceCA.pvk private key are now saved in your 
temporary folder. 

2. Install the root CA on the computer that is running Microsoft 
Dynamics NAV Server by using the Certificates snap-in. 

a. Start the Certificates snap-in for MMC on the computer that is 
running Microsoft Dynamics NAV Server, and then add the 
Certificates snap-in. 

b. In the Certificates snap-in box, click Computer account, and 
then click Next. 

c. In the Select Computer pane, click Local computer (the 
computer this console is running on), and then click Finish. 

d. Click OK to close the Add or Remove Snap-ins box. 

e. In the left pane of MMC, expand the Certificates (Local 
Computer) node.  

f. Expand the Trusted Root Certification Authorities node, right-click 
the Certificates subfolder, select All Tasks, and then click Import.  

g. In the Certificate Import Wizard, on the Welcome page, click 
Next. 
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h. On the File to Import page, click Browse. 
i. Browse to the RootNavServiceCA.cer certificate file, select the file, 

and then click Open.  
j. On the File to Import page, click Next.  
k. On the Certificate Store page, accept the default selection, and 

then click Next. 
l. On the Completing the Certificate Import Wizard page, click 

Finish. 

The RootNavServiceCA certificate is now visible in the list of trusted 
root CAs. 

3. Create a certificate revocation list for the root certification authority 
a. At the Visual Studio Command Prompt, type the following 

command: 

makecert -crl -n "CN=RootNavServiceCA" -r -sv RootNavServiceCA.pvk 
RootNavServiceCA.crl   

b. When you are prompted, enter the password that you used to 
create the root CA. 
 

4. Install the Certificate Revocation List on the Microsoft Dynamics NAV 
Server. 
a. In the Certificates snap-in, in the left pane of MMC, expand the 

Certificates (Local Computer) node.  
b. Expand the Trusted Root Certification Authorities node, right-click 

the Certificates subfolder, select All Tasks, and then click Import.  
c. In the Certificate Import Wizard, on the Welcome page, click 

Next.  
d. On the File to Import page, click Browse.  
e. In the File Type field, select Certificate Revocation List (*.crl).  

f. Browse to the RootNavServiceCA.crl file, select the file, and then 
click Open.  

g. On the File to Import page, click Next. 
h. On the Certificate Store page, accept the default selection, and 

then click Next.  
i. On the Completing the Certificate Import Wizard page, click 

Finish. Select the Trusted Root Certificate Authorities node, and 
then refresh the snap-in.  

A Certificate Revocation List folder that contains the 
RootNavServiceCA.crl file is created. 
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5. Create and install the test certificate on the Microsoft Dynamics NAV 
Server. 

a. At the Visual Studio command prompt, type the following 
command: 

makecert -sk NavServiceCert -iv RootNavServiceCA.pvk -n "CN=NavServiceCert" -
ic RootNavServiceCA.cer -sr localmachine -ss my -sky exchange -pe 
NavServiceCert.cer 

    Note: This command specifies the subject’s certificate name as 
NavServiceCert. You must have this certificate name when you configure the 
RoleTailored client for Windows.  

b. When you are prompted, enter the password that you used to 
create the root CA. In this case, "Pa$$w0rd". 

c. Select the Trusted Root Certificate Authorities node, and then 
refresh the snap-in. 

You now have the NavServiceCert.cer certificate file in your 
temporary folder. The certificate is installed under the Personal 
node in the Certificates snap-in. 

6. Grant the Microsoft Dynamics NAV Server service account access to 
the certificate’s private key. 

a. In the left pane of MMC, expand the Certificates (Local 
Computer) node, expand the Personal node, and then select the 
Certificates subfolder.  

b. In the right pane, right-click the NavServiceCert certificate, click 
All Tasks, and then click Manage Private Keys.   

c. In the Permissions for NavServiceCert private keys box, click 
Add.  

d. In the Select Users, Computers, Service Accounts, or Groups 
box, enter the name of the Microsoft Dynamics NAV Server 
service account, and then click OK. 

    Note: In a production environment, you run Microsoft Dynamics NAV Server 
under a dedicated domain user account instead of the less secure Network Service 
account. Because this is a test implementation, the Network Service account is 
acceptable.  

e. Select Allow Full Control, and then click OK.  
f. In the right pane, double-click the NavServiceCert certificate.  
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g. In the Certificate box, click the Details tab, and then select the 
Thumbprint field.  

Copy or note the value of the Thumbprint field. 

7. Reconfigure Microsoft Dynamics NAV Server to support logon over a 
WAN. 
a. Start the Microsoft Dynamics NAV Administration tool. 

b. Connect to the computer that is running Microsoft Dynamics 
NAV Server. 

c. In the middle pane, right-click the Microsoft Dynamics NAV 
Server instance that the RoleTailored client for Windows is using, 
and then select Stop. 

d. In the left pane, select the server instance that you have stopped. 
Make sure that the configuration is selected in the right pane. The 
middle pane will now show the configuration settings for the 
server instance.  

e. Select Edit at the bottom of the middle pane.  
f. On the Client Services tab, change the Credential Type option 

to UserName. When you change it to UserName, RoleTailored 
client for Windows users who connect to the server are prompted 
for user name and password credentials. 

g. On the Client Services tab, select the Certificate Thumbprint 
field and enter the value of the Thumbprint field in the previous 
procedure.  

h. Click Save to confirm the new settings. 
i. In the left pane, select the Microsoft Dynamics NAV Server to 

which the RoleTailored clients for Windows will connect. 
j. In the middle pane, right-click the Microsoft Dynamics NAV 

Server instance that the RoleTailored clients for Windows will be 
using, and then select Start. 
Close the Microsoft Dynamics NAV Administration tool 

Demonstration:  Implement Security Certificates in a 
Production Environment 

This demonstration describes the implementation of security certificates in 
production environments. The main difference with the previous demonstration is 
that you do not have to create the certificates yourself. Instead you will receive the 
certificates (and the detailed installation instructions) from a trusted provider.  
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The root CA must be installed on the computer that is running Microsoft 
Dynamics NAV Server and all computers that are running the RoleTailored client 
for Windows. The service certificate must only be installed on the computer that is 
running Microsoft Dynamics NAV Server. 

Most enterprises and hosting providers have their own infrastructure for issuing 
and managing certificates. You can also use these certificate infrastructures. The 
only requirement is that the service certificates must be set up for key exchange 
and therefore must contain both private and public keys. 

    Note: An instance of Microsoft Dynamics NAV Server that is configured for 
secure WAN communication always prompts RoleTailored client for Windows users 
for authentication when they start the client, even when the client computer is in 
the same domain as Microsoft Dynamics NAV Server. 

Prerequisites 

To complete this demonstration, you will need: 

• The Certificates snap-in for Microsoft Management Console (MMC). If 
you do not already have this snap-in installed, then follow these steps: 

o Click Start > Run, and then type "Mmc.exe". 

o In the console, on the File menu, click Add/Remove Snap-in. 

o In the Add Standalone Snap-in box, click Certificates > 
Computer Account > Local Computer > Add. 

Microsoft Dynamics NAV Server Configuration 

After you have installed the root CA and the service certificate on the computer 
that is running Microsoft Dynamics NAV Server, you must grant access to the 
service account that is associated with the server so that the service account can 
access the service certificate’s private key. You must also change the configuration 
settings for Microsoft Dynamics NAV Server to enable remote logins. 

Demonstration Steps 

1. Install the Root Certificate on the Microsoft Dynamics NAV Server 

a. Follow the installation instructions from the trusted provider. 
 

2. Install the service certificate on the Microsoft Dynamics NAV Server 

a. Follow the installation instructions from the trusted provider. 
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3. Grant the Microsoft Dynamics NAV Server service account access to 
the certificate’s private key. 

a. In the left pane of MMC, expand the Certificates (Local 
Computer) node, expand the Personal node, and then select the 
Certificates subfolder.  

b. In the right pane, right-click the service certificate, select All 
Tasks, and then click Manage Private Keys. 

c. In the Permissions box for the certificate, click Add. 
d. In the Select Users, Computers, Service Accounts, or Groups 

box, enter the name of the dedicated domain user account that is 
associated with Microsoft Dynamics NAV Server, and then click 
OK.  

e. In the Full Control field, select Allow, and then click OK.  
f. In the right pane, double-click the certificate. 

g. In the Certificate box, click the Details tab, and then select the 
Thumbprint field.  

h. Copy or note the value of the Thumbprint field. 
 

4. Reconfigure Microsoft Dynamics NAV Server to support logon over a 
WAN. 
a. Start the Microsoft Dynamics NAV Administration tool. 

b. Connect to the computer that is running Microsoft Dynamics 
NAV Server. 

c. In the middle pane, right-click the Microsoft Dynamics NAV 
Server instance that the RoleTailored client for Windows is using, 
and then select Stop. 

d. In the left pane, select the server instance that you have stopped. 
Make sure that the configuration is selected in the right pane. The 
middle pane will now show the configuration settings for the 
server instance.  

e. Select Edit at the bottom of the middle pane.  
f. On the Client Services tab, change the Credential Type option 

to UserName. When you change it to UserName, RoleTailored 
client for Windows users who connect to the server are prompted 
for user name and password credentials. 

g. On the Client Services tab, select the Certificate Thumbprint 
field and enter the value of the Thumbprint field in the previous 
procedure.  
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h. Click Save to confirm the new settings. 
i. In the left pane, select the Microsoft Dynamics NAV Server to 

which the RoleTailored clients for Windows will connect. 
j. In the middle pane, right-click the Microsoft Dynamics NAV 

Server instance that the RoleTailored clients for Windows will be 
using, then select Start. 

k. Close the Microsoft Dynamics NAV Administration tool. 
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NAS Services 

NAV Application Server 

NAS (NAV Application Server) is a middle-tier server component that executes 
business logic without a user interface or user interaction. In Microsoft Dynamics 
NAV 2013, NAS is re-engineered to be one of the client services in Microsoft 
Dynamics NAV Server. Because NAV Application Server does not have a user 
interface, NAS services are managed completely from the Microsoft Dynamics 
NAV Server Administration tool (the NAS Services tab).  

 

FIGURE 3.11: THE NAS SERVICES TAB IN MICROSOFT DYNAMICS NAV 
ADMINISTRATION WINDOW 

If you have applications that used the NAS available with earlier version of 
Microsoft Dynamics NAV, you should now be able to use these applications with 
Microsoft Dynamics NAV 2013 without significant modifications. Modifications are 
required for applications that use COM, because server-side COM is no longer 
supported in Microsoft Dynamics NAV 2013. This is because not all COM 
components can execute on 64-bit operating systems. 
 
NAS services can help you manage and optimize access to the Microsoft Dynamics 
NAV database. NAS Services in Microsoft Dynamics NAV Server support 
applications such as ADCS, Microsoft Office Outlook Integration, and the NAV Job 
Queue. 
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NAS Services Applications in Dedicated Server Instances 

We recommend that you create a separate Microsoft Dynamics NAV Server 
instance for each NAS services application.  

There are multiple reasons for running NAS services sessions in dedicated 
Microsoft Dynamics NAV Server instances:  

• Efficiency and convenience:  
When you change any Microsoft Dynamics NAV Server setting, you 
must restart the instance for the change to take effect. This interrupts 
all services that use that instance. So if you are running different types 
of services in the same instance—for example, RoleTailored client for 
Windows services and NAS services—changing the settings for either 
service type will require a server instance restart that interrupts all 
other service types running through that instance.   
 
Even for different types of NAS services applications, it is wise to run 
each application in a separate server instance. For example, if you will 
be using NAS services for a Microsoft Office Outlook Integration 
application and also for a NAV Job Queue application, create a 
separate Microsoft Dynamics NAV Server instance for each NAS 
services application. Then, if you have to modify settings for the 
Microsoft Office Outlook Integration application, you will not affect 
the NAV Job Queue application, just as you will not affect the 
Microsoft Office Outlook Integration application if you modify the 
NAV Job Queue application. 

• Performance:  

Configuring NAS services applications to use separate server instances 
makes better use of the server’s resources. This lets you run more 
applications with less degradation.  

• Efficient error tracking:  

If a NAS services session terminates in an error, and there are no other 
services that are running on the Microsoft Dynamics NAV Server 
instance, the service instance terminates and can be handled like any 
other Windows service. For example, you could configure the 
Recovery tab on the Service configuration item in Control Panel to 
restart or otherwise manage the service. 

    Note: If your NAS services application must handle a large number of 
requests, you can have multiple Microsoft Dynamics NAV Server computers run the 
same NAS services application so that requests can be handled faster. 
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NAS Services Settings 

You configure NAS services by using the settings on the NAS Services tab in 
Microsoft Dynamics NAV Server Administration tool: 

Parameter Description 

Company Specifies the Microsoft Dynamics NAV 
company whose data opens when NAS 
services start. The company name is case-
sensitive. 

Startup Codeunit Specifies the codeunit that contains the 
method that will be called by the NAS 
Startup Method. 
Example values: 

• 0  

When Startup Codeunit is set to 0, 
NAS services do not start. This is the 
default value. 

• 1  

When NAS services start, they run the 
trigger specified by the Startup 
Method in codeunit 1. 

• 450  

When NAS services start, they run 
codeunit 450 (Job Queue – NAS Start 
Up) and call the method specified by 
Startup Method. 

When the NAS Startup Codeunit is a 
single instance codeunit, the NAS 
services session will remain alive even 
after all code in the specified NAS 
Startup Method is executed.  
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Parameter Description 

Startup Method Specifies the method that will be called in 
the NAS Startup Codeunit.  
Example values: 

• “”  

If no start method is specified (null 
string), the OnRun trigger is called. 

• StartNAS  

NAS services runs the StartNAS method 
in the NAS Startup Codeunit.  

Startup Argument Specifies a string argument to be used 
when NAS services start. The argument 
typically specifies an application type, 
sometimes with additional configuration 
information.  

• Example values: 

• "ADCS, ADCSID=1" 

• "OSYNCH"  

• "JOBQUEUE" 

Enable Debugging When selected, specifies that the NAS 
services session wait 60 seconds before 
executing the first C/AL statement, to 
make time for opening and attaching the 
NAV Debugger to the NAS services 
session. 

NAS services sessions execute in the time zone specified by the Services Default 
Time Zone parameter (on the General tab) for Microsoft Dynamics NAV Server.  
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Lab 3.1: Managing NAV Server Instances 
Scenario 

Tim has successfully finished his first installation of Microsoft Dynamics NAV 2013. 
During the installation, he also gained some experience with Microsoft Dynamics 
NAV Setup. 

As a next step, he wants to redo the installation and set up a production and test 
environment. For this new installation, he will not use the SQL Server Express 
Edition; he will use an existing instance of SQL Server to install the databases. Next 
he will install two Microsoft Dynamics NAV Server instances, one for the 
production and one for the test environment. Finally he will disable both SOAP 
and OData services for the two environments. 

Exercise 1: Install Database to an Existing SQL Server 
(Production Environment) 
Exercise Scenario 

Tim starts by installing the NAV database to an existing instance of SQL Server. 
This instance is the default instance of SQL Server.  

Task 1: Log On to the SQL Server as Administrator 

High Level Steps 
1. Log on to the server as Administrator. 

Detailed Steps 
1. Log on to the server as Administrator. 

a. On the Desktop, press CTRL+ALT+DEL. 
b. In the Password field, type the password for the Administrator 

user: 
"Passw0rd". 

c. Press ENTER (or click the arrow icon at the right of the Password 
field. 

Task 2: Start Microsoft Dynamics NAV Setup 

High Level Steps 
1. Insert the Microsoft Dynamics NAV 2013 product DVD in the DVD 

drive. 
2. Start Microsoft Dynamics NAV Setup. 
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Detailed Steps 
1. Insert the Microsoft Dynamics NAV 2013 product DVD in the DVD 

drive. 
a. Open the DVD drive by pressing the Eject button on the physical 

drive. 

b. Put the DVD on the tray. 
c. Press the Close button to close the DVD drive. 

 
2. Start Microsoft Dynamics NAV Setup. 

a. Open Windows Explorer. 
b. Select Computer in the left pane to see a list of available drives. 
c. Select the DVD drive that contains the product DVD.  
d. In the root folder of the selected drive, double-click setup.exe. 

e. If the Open File - Security Warning box pops up (asking 
whether you want to run the setup.exe application), click Run. 

Task 3: Select the Installation Option 

High Level Steps 
1. Select the installation option. 

Detailed Steps 
1. Select the installation option. 

a. In the Welcome to the Microsoft Dynamics NAV 2013 Setup 
window, click Next. 

b. On the Microsoft Software License Terms page, click I Accept.  
c. On the Microsoft Dynamics NAV Setup page, click Choose an 

Installation Option. 

d. On the Choose an installation option page, click Custom. 
e. On the Customize the installation page, click the icon at the left 

of the SQL Server Database Components node. The node will 
expand. 

f. Click the icon at the left of the Demo Database node. 
g. Select Run from My Computer. 
h. On the Customize the installation page, click Next. 
i. On the Specify parameters page, clear the SQL Server Instance 

field.  
j. On the Specify parameters page, enter NAV_DEMO2013_LIVE in 

the SQL Database field.  
k. On the Specify parameters page, verify that the Replace 

Existing  Database field is set to No. 
l. Click Apply to start the installation. 
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Setup will now install the demonstration database to the default 
instance of SQL Server.  

Task 4: Verify Installation 

High Level Steps 
1. Start SQL Server Management Studio (SSMS). 
2. Check the Existing Databases. 

Detailed Steps 
1. Start SQL Server Management Studio (SSMS). 

a. On the Windows Taskbar, click Start > All Programs > 
Microsoft SQL Server 2012 > SQL Server Management 
Studio. 

b. In the Connect to Server box, in the Server Type field, click 
Database Engine. 

c. In the Server name field, enter the name of the SQL Server to 
which you want to connect.  
 
To connect to the current computer, you can enter either the 
computer name or “(local)” or “.” (dot).  
 
If you want to connect to a specific instance of SQL Server, enter 
the full name as follows: 
<SQL Server Name>\<Instance Name> 

d. In the Authentication field, select Windows Authentication.  
e. Click Connect. 

 
2. Check the Existing Databases. 

a. In the Object Explorer window, expand the server node.  
b. Expand the Databases node.   

The newly installed database NAV_DEMO2013_LIVE is in the list. 
c. Close SQL Server Management Studio. 
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Exercise 2: Setting Up the SQL Database for the Test 
Environment 
Exercise Scenario 

Tim wants to duplicate the NAV_DEMO2013_LIVE database so he can set up a test 
environment. He wants to use the same SQL Server and the same instance of SQL 
Server for both environments. As he cannot use Microsoft Dynamics NAV Setup to 
install additional copies of the database on the same Instance of SQL Server, he 
decides to make a backup of the production database by using SQL Server 
Management Studio. As a next step, Tim will restore the backup to create a 
database for the test environment. 

Task 1: Start SQL Server Management Studio 

High Level Steps 
1. Start SQL Server Management Studio. 

Detailed Steps 
1. Start SQL Server Management Studio. 

a. On the Windows Taskbar, click Start > All Programs > 
Microsoft SQL Server 2012 > SQL Server Management 
Studio. 

b. In the Connect to Server box, in the Server Type field, select 
Database Engine.  

c. In the Server name field, enter the name of the SQL Server to 
which you want to connect.  

d. In the Authentication field, select Windows Authentication.  
e. Click Connect. 

Task 2: Back Up the Production Database 

High Level Steps 
1. Back up the production database. 

Detailed Steps 
1. Back up the production database. 

a. In the Object Explorer pane, expand the server node. 
b. In the Object Explorer pane, expand the Databases node. 
c. Right-click the NAV_DEMO2013_LIVE database, and then click 

Tasks > Back Up. 

d. In the Back Up Database – NAV_DEMO2013_LIVE window, on 
the General pane, check that the NAV_DEMO2013_LIVE database 
is selected in the Source – Database field. 

e. Check that the Backup type is set to Full. 
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f. Check that the backup destination is set to Disk (Destination – 
Backup to). As this is the first time that you make a backup of 
this database, you can accept the default backup file name. 

    Detailed Steps: When you make a backup of a database, verify that the 
backup destination file already exists before you start the actual backup procedure. 
Then, you will not accidentally overwrite or modify an existing backup set.   

g. Click OK to start the backup procedure.  

When the backup is complete, a message box appears with the 
text “The backup of database ‘NAV_DEMO2013_LIVE’ completed 
successfully.”  

h. Click OK to close the box. 

Task 3: Restore the Backup 

High Level Steps 
1. Restore the backup (test environment). 

Detailed Steps 
1. Restore the backup (test environment). 

a. In SQL Server Management Studio, in the Object Explorer pane, 
right-click the Databases node and then select Restore 
Database.  

b. In the Restore Database window, under Source, select the 
Device option. 

c. Click the button at the right of the Device option. 
d. In the Select backup devices window, in the Backup Media 

field, select File. 

e. In the Select backup devices window, click Add. 
f. In the Locate Backup File window, select the backup file (*.BAK) 

you created in the previous task.  
g. Click OK to close the Locate Backup File window. 

h. Click OK to close the Select backup devices window.  

A list of backup sets included in the selected backup file is now 
displayed in the Select backup sets to restore list. In this case, 
there is only one backup set.  

i. In the Restore database window, select the backup set to 
restore. To do this, put a check mark in the Restore column of 
the backup set to restore. 

j. In the Destination Database field, enter NAV_DEMO2013_TEST.  
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k. In the Select a page pane, select Files.  
l. In the Restore database files as list box, on the row with File Type 

Rows Data, click the button at the right of the Restore as column. 
m. In the Locate Database Files window, enter 

NAV_DEMO2013_TEST.mdf in the File Name field. 
n. Click OK to close the Locate Database Files window. 

o. In the Restore database files as list box, on the row with File Type 
Log, click the button at the right of the Restore as column. 

p. In the Locate Database Files window, enter 
NAV_DEMO2013_TEST.ldf in the File Name field. 

q. Click OK to close the Locate Database Files window. 
r. Click OK to start the restore procedure.  

When the restore is completed, a message box appears with the 
text “The restore of database ‘NAV_DEMO2013_TEST’ completed 
successfully.”  

s. Click OK to close the box. 

Task 4: Verify Installation 

High Level Steps 
1. Check the SQL Server databases. 

Detailed Steps 
1. Check the SQL Server databases. 

a. In the Object Explorer window, right-click the Databases node 
and then select Refresh.  

Both the NAV_DEMO2013_LIVE and NAV_DEMO2013_TEST databases 
are in the list. 

b. Close SQL Server Management Studio. 

Task 5: Assign database permissions to the NAV Server service 
account 

High Level Steps 
1. Add a login for the service account. 
2. Assign database permissions to the service account. 

Detailed Steps 
1. Add a login for the service account. 

a. In SQL Server Management Studio, expand the Security node.  

b. Right-click the Logins node and select New Login. 
c. In the Login – New dialog box, click Search.  
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d. In the Select User, Service Account, or Group window, enter 
“CONTOSO\NAV2013svc” in the Enter the object name to 
select box. 

e. Click Check Names.  
f. Click OK to close the Select User, Service Account, or Group 

window.  
 

2. Assign database permissions to the service account. 
a. In the Login Properties – CONTOSO\NAV2013svc window, in 

the Select a page pane, click User Mapping.  

b. In the Users mapped to this login list, select the 
NAV_DEMO2013_TEST database.  

c. Put a check mark in the Map column.  
d. In the Database role membership for list, select the db_owner 

role. 
e. Repeat steps b to d for the NAV_DEMO2013_LIVE database.  
f. Click OK to close the Login Properties window.  

Exercise 3: Installing Microsoft Dynamics NAV Server 
(Production Environment) 
Exercise Scenario 

Now the databases for the production and test environments are ready. Tim will 
install the Microsoft Dynamics NAV Server software on the SQL Server. At the 
same time, he will install the Microsoft Dynamics NAV Administration tool so he 
can manage the configuration of the server instance. He starts with the server 
instance for the production environment.   

Task 1: Log On to the Server as Administrator 

High Level Steps 
1. Log on to the server as Administrator. 

Detailed Steps 
1.  Log on to the server as Administrator. 

a. On the Desktop, press CTRL+ALT+DEL. 
b. In the Password field, enter the password for the Administrator 

user: 
Passw0rd 

c. Press ENTER (or click the arrow icon at the right of the Password 
field). 
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Task 2: Start Microsoft Dynamics NAV Setup 

High Level Steps 
1. Insert the Microsoft Dynamics NAV 2013 product DVD in the DVD 

drive. 

2. Start Microsoft Dynamics NAV Setup. 

Detailed Steps 
1. Insert the Microsoft Dynamics NAV 2013 product DVD in the DVD 

drive. 
a. Open the DVD drive by pressing the Eject button on the physical 

drive. 
b. Put the DVD on the tray. 

c. Press the Close button to close the DVD drive. 

2. Start Microsoft Dynamics NAV Setup. 

a. Open Windows Explorer. 
b. In the left pane, select Computer to see a list of available drives. 

c. Select the DVD drive that contains the product DVD.  
d. In the root folder of the selected drive, double-click setup.exe. 
e. If the Open File - Security Warning box pops up (asking 

whether you want to run the setup.exe application), click Run. 

Task 3: Select the Installation Option 

High Level Steps 
1. Select the components to install. 

Detailed Steps 
1. Select the components to install. 

a. In the Welcome to the Microsoft Dynamics NAV 2013 Setup 
window, on the Maintenance page, select Add or remove 
components. 

b. On the Customize the installation page, click the icon at the left 
of the Server node.  

c. Select Run All from My Computer. 
d. On the Customize the installation page, click the icon at the left 

of the Administration tool node. 
e. Select Run from My Computer. 
f. On the Customize the installation page, click Next. 
g. On the Specify parameters page, in the Service Name field, 

enter DynamicsNAVLive.  
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h. On the Specify parameters page, in the Password field, enter 
the password for the Service account. 

i. Click Apply to start the installation. 

Setup will now install the selected components including 
Microsoft .NET Framework 4.0 (in case this is not installed).  

j. Click Close to exit Microsoft Dynamics NAV Setup. 

Task 4: Verify Installation 

High Level Steps 
1. Open Services panel. 

Detailed Steps 
1. Open Services panel. 

a. On the Windows Taskbar, click Start > All Programs > 
Accessories > System Tools > Control Panel > System and 
Security > Administrative Tools > Services. 

b. In the right pane, scroll down the list of services and check for a 
service called Microsoft Dynamics NAV Server 
[DynamicsNAVLive]. 

By default services are sorted alphabetically by Name (in ascending order). If this 
is not the case, you can click the header label of the Name column to change the 
sorting. You can also press M on your keyboard to move immediately to the first 
service whose name starts with M. 

Exercise 4: Creating Server Instance for the Test 
Environment 
Exercise Scenario 

Next in Tim’s planning is a step to create the Microsoft Dynamics NAV Server 
instance for the test environment. Tim will use the Microsoft Dynamics NAV 
Administration tool to do this.  
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Task 1: Start Microsoft Dynamics NAV Administration 

High Level Steps 
1. Start Microsoft Dynamics NAV Administration tool. 

Detailed Steps 
1. Start Microsoft Dynamics NAV Administration tool. 

a. On the Windows Taskbar, click Start > All Programs > 
Microsoft Dynamics NAV Administration. 

Task 2: Create a New Server Instance 

High Level Steps 
1. Create a new server instance. 

Detailed Steps 
1. Create a new server instance. 

a. In the left pane, select Microsoft Dynamics NAV (local). 
b. In the right pane, click Add Instance. 
c. In the Server Instance window, in the Server Instance field, 

enter DynamicsNAVTest.  

d. In the Management Services Port field, type “7055”. 
e. In the Client Services Port field, type “7056”. 
f. In the SOAP Services Port field, type “7057”. 
g. In the OData Services Port field, type “7058”. 

h. In the Service Account field, select User Account.  
i. In the User Name field, type “NAV2013Svc”. 
j. In the Domain field, type “CONTOSO”.  
k. In the Password field, type the password for the NAV2013svc 

account.  
l. Type the password again in the Confirm Password field. 
m. Click OK to close the Server Instance window. 
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Task 3: Configure the Server Instance 

High Level Steps 
1. Configure the server instance. 

Detailed Steps 
1. Configure the server instance. 

a. In the left pane of the Microsoft Dynamics NAV Administration 
tool, double-click Microsoft Dynamics NAV (local).  

b. In the left pane, select the DynamicsNAVTest instance. The 
configuration settings will now appear in the middle pane. 

c. At the bottom of the middle pane, click Edit. 
d. On the General tab, change the Database Name to 

NAV_DEMO2013_TEST. 
e. Click Save to confirm the new settings. 

Task 4: Start the Server Instance 

High Level Steps 
1. Start the server instance. 
2. Close Microsoft Dynamics NAV Administration. 

Detailed Steps 
1. Start the server instance. 

a. In the left pane of the Microsoft Dynamics NAV Administration 
tool, click Microsoft Dynamics NAV (local).  

b. In the middle pane, right-click the DynamicsNAVTest instance, 
and then click Start.  

In the Change Microsoft Dynamics NAV Server Instance Status 
box, click OK. 

2. Close Microsoft Dynamics NAV Administration. 
a. On the File menu, click Exit to close Microsoft Dynamics NAV 

Administration. 

Exercise 5: Disabling Web Services 
Exercise Scenario 

When he configures the new server instance for the test environment, Tim notices 
that not only are client services enabled, but also SOAP web services and OData 
web services. Because these service types are currently not used, Tim decides to 
disable the service types in both production and test environment.   
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Task 1: Disable Service Types 

High Level Steps 
1. Start Microsoft Dynamics NAV Administration. 
2. Reconfigure the server instance (production environment). 

3. Reconfigure the server instance (test environment). 

Detailed Steps 
1. Start Microsoft Dynamics NAV Administration. 

a. On the Windows Taskbar, click Start > All Programs > 
Microsoft Dynamics NAV Administration. 
 

2. Reconfigure the server instance (production environment). 

a. In the left pane of the Microsoft Dynamics NAV Administration 
tool, double-click Microsoft Dynamics NAV (local).  

b. In the left pane, click the DynamicsNAVLive instance. The 
configuration settings will now be displayed in the middle pane. 

c. At the bottom of the middle pane, click Edit. 
d. On the SOAP Services tab, clear the Enable SOAP Services option. 
e. On the OData Services tab, clear the Enable OData Services 

option. 

f. Click Save to confirm the new settings. 
 

3. Reconfigure the server instance (test environment). 
a. In the left pane, select the DynamicsNAVTest instance. The 

configuration settings will now be displayed in the middle pane. 
b. At the bottom of the middle pane, click Edit. 
c. On the SOAP Services tab, clear the Enable SOAP Services option. 

d. On the OData Services tab, clear the Enable OData Services 
option. 

e. Click Save to confirm the new settings. 

Task 2: Restart Server Instances 

High Level Steps 
1. Restart server instances. 

2. Close Microsoft Dynamics NAV Administration. 
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Detailed Steps 
1. Restart server instances. 

a. In the left pane of the Microsoft Dynamics NAV Administration 
tool, click Microsoft Dynamics NAV (local).  

b. In the middle pane, right-click the DynamicsNAVLive instance, 
and then click Restart. 

c. In the Change Microsoft Dynamics NAV Server Instance Status 
box, click OK. 

d. Repeat steps b and c for the DynamicsTest instance. 
 

2. Close Microsoft Dynamics NAV Administration. 
a. On the File menu, click Exit to close Microsoft Dynamics NAV 

Administration. 
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Lab 3.2: Setting up NAS Services 
Scenario 

A recent meeting has pointed out that people in the customer service team spend 
lots of time executing tasks manually. Processes could be optimized if some 
manual tasks could be scheduled and executed automatically. Because of this 
meeting, Marie, the customer service manager, contacts Tim to check if this is 
possible and what has to be done.  

Tim tells Marie that he can do this by using the Job Queue functionality in 
Microsoft Dynamics NAV. Tim will enable the Job Queue in the test environment. 
To do this, he has to set up NAS services. He decides to create a new server 
instance, so he can easily start and stop the Job Queue functionality without 
affecting the other users in the test environment.  

Exercise 1: Creating a Server Instance 

Task 1: Start Microsoft Dynamics NAV Administration 

High Level Steps 
1. Start Microsoft Dynamics NAV Administration tool. 

Detailed Steps 
1. Start Microsoft Dynamics NAV Administration tool. 

a. On the Windows Taskbar, click Start > All Programs > 
Microsoft Dynamics NAV Administration. 

Task 2: Create a New Server Instance 

High Level Steps 
1. Create a new server instance. 

Detailed Steps 
1. Create a new server instance. 

a. In the left pane, select Microsoft Dynamics NAV (local). 
b. In the right pane, click Add Instance. 
c. In the Server Instance window, in the Server Instance field, type 

“DynamicsNAVTest-NAS”.  

d. In the Management Services Port field, type “7065”. 
e. In the Client Services Port field, type “7066”. 
f. In the SOAP Services Port field, type “7067”. 

g. In the OData Services Port field, type “7068”. 
h. In the Service Account field, select User Account.  
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i. In the User Name field, type “NAV2013Svc”. 
j. In the Domain field, type “CONTOSO”.  

k. In the Password field, type the password for the NAV2013svc 
account.  

l. Type the password again in the Confirm Password field. 
m. Click OK to close the Server Instance window. 

Task 3: Configure the Server Instance 

High Level Steps 
1. Configure the server instance. 

Detailed Steps 
1. Configure the server instance. 

a. In the left pane of the Microsoft Dynamics NAV Administration 
tool, double-click Microsoft Dynamics NAV (local).  

b. In the left pane, select the DynamicsNAVTest-NAS instance. The 
configuration settings will now appear in the middle pane. 

c. At the bottom of the middle pane, click  Edit  
d. On the General tab, change the Database Name to 

NAV_DEMO2013_TEST. 
e. Click Save to confirm the new settings. 

Exercise 2: Setting Up NAS Services 

Task 1: Configure NAS Services 

High Level Steps 
1. Configure NAS services. 

Detailed Steps 
1. Configure NAS services. 

a. In the left pane of the Microsoft Dynamics NAV Administration 
tool, double-click Microsoft Dynamics NAV (local).  

b. In the left pane, select the DynamicsNAVTest-NAS instance. The 
configuration settings will now appear in the middle pane. 

c. At the bottom of the middle pane, click Edit. 
d. On the NAS Services tab, change the Company Name to 

CRONUS International Ltd. 
e. In the Startup Codeunit field, type “1”. 

f. In the Startup Method field, type “NASHandler”.  
g. In the Startup Argument field, type “JOBQUEUE”. 
h. Click Save to confirm the new settings. 
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Exercise 3: Disabling Other Services 

Task 1: Disable Client Services 

High Level Steps 
1. Disable client services. 

Detailed Steps 
1. Disable client services. 

a. On the Client Services tab, clear the Enable Client Services check 
box. 

Task 2: Disable SOAP services 

High Level Steps 
1. Disable SOAP services. 

Detailed Steps 
1. Disable SOAP services. 

a. On the SOAP Services tab, clear the Enable SOAP Services 
check box. 

Task 3: Disable OData Services 

High Level Steps 
1. Disable OData services. 

Detailed Steps 
1. Disable OData services. 

a. On the OData Services tab, clear the Enable OData Services 
check box. 

Task 4: Save Settings 

High Level Steps 
1. Save settings. 

Detailed Steps 
1. Save settings. 

a. Click Save to confirm the new settings. 
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Exercise 4: Restarting NAS Services 

Task 1: Restart Server Instances 

High Level Steps 
1. Restart server instances 

Detailed Steps 
1. Restart server instances 

a. In the left pane of the Microsoft Dynamics NAV Administration 
tool, click Microsoft Dynamics NAV (local).  

b. In the middle pane, right-click the DynamicsNAVTest-NAS 
instance, and then click Restart. 

c. In the Change Microsoft Dynamics NAV Server Instance Status 
box, click OK. 

Task 2: Verify Service Status 

High Level Steps 
1. Verify service status in Microsoft Dynamics NAV Administration. 
2. Close Microsoft Dynamics NAV Administration 

Detailed Steps 
1. Verify service status in Microsoft Dynamics NAV Administration. 

a. In the left pane of the Microsoft Dynamics NAV Administration 
tool, click Microsoft Dynamics NAV (local).  

b. In the middle pane, check that the Status column for the 
DynamicsNAVTest-NAS instance is set to Running. 
 

2. Close Microsoft Dynamics NAV Administration 
a. On the File menu, click Exit to close Microsoft Dynamics NAV 

Administration. 
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Module Review 

Test Your Knowledge 

Test your knowledge with the following questions. 

1. To create a new company in the Microsoft Dynamics NAV database, you must 
use: 

(   ) A Microsoft Dynamics NAV PowerShell session 

(   ) The RoleTailored client for Windows 

(   ) The Microsoft Dynamics NAV Administration tool 

(   ) Any of these three tools 

2. Which of the following is true about the Development Environment? 

(   ) You can install the Development Environment without installing the 
RoleTailored client for Windows. 

(   ) The Development Environment has the same user interface as the 
RoleTailored client for Windows and contains some additional 
development functions. 

(   ) The Development Environment uses the server tier to connect to the 
database. 

(   ) You can use the Development Environment to manage licenses. 

3. How do you install additional server instances on a Microsoft Dynamics NAV 
Server?  

(   ) You copy the Microsoft Dynamics NAV Server software from the 
product DVD to a different folder, and edit the CustomSettings.config 
file. 

(   ) You use Microsoft Dynamics NAV Setup to install Microsoft Dynamics 
NAV Server to a different folder. 

(   ) You use the Microsoft Dynamics NAV Administration tool to create 
additional server instances. 
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(   ) You use the Development Environment to create a new database on a 
separate SQL . 

(   ) You cannot install multiple server instances on the same . Each server 
instance must be installed on a separate server. 

4. What is the default port number for client services? 

(   ) 2407 

(   ) 5555 

(   ) 7045 

(   ) 7046 

5. Enabling RoleTailored client for Windows connections over a wide area 
network requires: 

(   ) Administration on the RoleTailored client for Windows computer only. 

(   ) Administration on the Microsoft Dynamics NAV Server only. 

(   ) Administration on both the Microsoft Dynamics NAV Server and 
RoleTailored client for Windows computers. 

(   ) No administration. By default, this is enabled. 

(   ) No administration, because this is impossible. 

6. To create users, profiles and permission sets in Microsoft Dynamics NAV 2013, 
you must use: 

(   ) The RoleTailored client for Windows 

(   ) The Development Environment 

(   ) The Microsoft Dynamics NAV Administration tool 

(   ) Microsoft SQL Server 

(   ) Internet Information Server 
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Test Your Knowledge Solutions 

Module Review and Takeaways 

1. To create a new company in the Microsoft Dynamics NAV database, you must 
use: 

(   ) A Microsoft Dynamics NAV PowerShell session 

(√) The RoleTailored client for Windows 

(   ) The Microsoft Dynamics NAV Administration tool 

(   ) Any of these three tools 

2. Which of the following is true about the Development Environment? 

(   ) You can install the Development Environment without installing the 
RoleTailored client for Windows. 

(   ) The Development Environment has the same user interface as the 
RoleTailored client for Windows and contains some additional 
development functions. 

(   ) The Development Environment uses the server tier to connect to the 
database. 

(√) You can use the Development Environment to manage licenses. 

3. How do you install additional server instances on a Microsoft Dynamics NAV 
Server?  

(   ) You copy the Microsoft Dynamics NAV Server software from the 
product DVD to a different folder, and edit the CustomSettings.config 
file. 

(   ) You use Microsoft Dynamics NAV Setup to install Microsoft Dynamics 
NAV Server to a different folder. 

(√) You use the Microsoft Dynamics NAV Administration tool to create 
additional server instances. 

(   ) You use the Development Environment to create a new database on a 
separate SQL . 

(   ) You cannot install multiple server instances on the same . Each server 
instance must be installed on a separate server. 
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4. What is the default port number for client services? 

(   ) 2407 

(   ) 5555 

(   ) 7045 

(√) 7046 

5. Enabling RoleTailored client for Windows connections over a wide area 
network requires: 

(√) Administration on the RoleTailored client for Windows computer only. 

(   ) Administration on the Microsoft Dynamics NAV Server only. 

(   ) Administration on both the Microsoft Dynamics NAV Server and 
RoleTailored client for Windows computers. 

(   ) No administration. By default, this is enabled. 

(   ) No administration, because this is impossible. 

6. To create users, profiles and permission sets in Microsoft Dynamics NAV 2013, 
you must use: 

(√) The RoleTailored client for Windows 

(   ) The Development Environment 

(   ) The Microsoft Dynamics NAV Administration tool 

(   ) Microsoft SQL Server 

(   ) Internet Information Server 
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